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1 The GeoDAS Application  

1.1 Introduction 
This manual describes the GeoSIG Data Acquisition System (hereafter GeoDAS or just program, 
application). GeoDAS is a graphical Microsoft Windows-based application running under Windows 
9x/2000/NT4/XP. In case of Windows 95, at least release 2 (SR2) is required. 
 
This Program is used for instrument configuration and for acquisition of data provided by any standard 
GeoSIG instrument. Data is delivered through serial communication channels. Two types of data delivery are 
supported. The first type is event downloading. In this case the instrument is configured as a seismic 
recorder, which detects events and keeps them locally in the instrument memory. These files are transferred 
to the PC via telephone line or direct link to GeoDAS. The second type is a continuous telemetry link or direct 
connection via cable providing near real-time data from the instrument, which is configured as digitiser in 
such case. If the serial channels to an instrument are bi-directional ones, GeoDAS can perform full 
configuration of the remote instrument and can monitor its state of health. 
 
GeoDAS general tasks: 

- Setup of an instrument.  One can change any parameters of an instrument with GeoDAS. 
- State of health (SOH) monitoring. GeoDAS performs permanent or periodical monitoring of an 

instrument status. 
- Downloading of the event files from an instrument working as a recorder 
- Off-line event data view and simple data analysis 
- Support for serial data streams (GSBU GeoSIG-Bergen and CWB formats) 
- Logger features. GeoDAS keeps important messages in a log file. 
- Real-time data viewer for an instrument, which provides serial data stream. 
 

GeoDAS has been designed to meet all requirements with respect to almost every possible application. It 
covers all the best features of the various GeoSys/SIG/Terra Tech. software products like AllView, 
CloseView, FieldView and GeoView. The program has an open architecture not only for multiple local 
recorders connected to the standard serial port, but also for networking of local recorders, supporting modem 
and network communications, including communication via Internet (TCP/IP protocol). These features 
provide flexible interfacing between GeoSIG recorders and users irrespective of how far they are located from 
each other. 
 
Additionally to the features above, GeoDAS allows all the Windows standard functionality to be used in an 
easy and intuitive way. The Program provides a perfect software interface between users (operators) and 
hardware based on GeoSIG recorders of GSR/GCR/GBV product lines. Besides that, GeoDAS provides data 
analysis, which has been developed mainly for civil engineering purposes and preliminary seismic analysis of 
recorded data. With GeoDAS one can set any configuration of GeoSIG recorders, which is supported by 
current versions of hardware. Furthermore, the program keeps compatibility with the previous versions of 
GeoSys recorders based on GSR-12/16 product line as well as networks, such as recorders united in GNC-
CNR systems. GeoDAS supports data exchange between the recorders and the PC both in interactive and 
automatic modes of operation.  
 

1.2 GeoDAS Off-line Data Viewer  
The Off-Line Data Viewer (hereafter ODV) is intended for reviewing and interactive analysis of the digital 
signals off-line. Original waveforms are taken from a file, which can have one of the standard formats created 
or supported by other GeoSIG software and by the data recorders. 
  
ODV is developed for Windows OS platforms but it is intended to keep continuity from old GeoSys DOS-
based analysis software like AllView, CloseView, FieldView and SIG DOS-based analysis software like 
SMACH and SMR. 
 
ODV supports various numbers of data channels in such way that operators could display on the screen and 
plot any set of them in any combination, make scaling, zooming, axis style changing, export to and import 
from various data formats, etc. in intuitive manner. Mathematical analysis will include such operations like 
digital filtering, response spectra calculation, integration and differentiation of signals, CAV calculation and 
others. 
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ODV is an integral part of GeoDAS. Extended analysis functionality is provided as an option, which can or 
cannot be included into the standard software packet shipped along with an instrument. This part is supposed 
to support math functions for data analysis. 
In case of the GeoDAS data analysis package (P/N GEO-DAP) has not been purchased, the “Analysis” menu 
is greyed, but can be activated at any later time by purchasing a valid registration number from GeoSIG Ltd. 

1.3 System Resources 
GeoDAS runs on IBM PC compatible computers, including laptop models, and communicates to the GSR, 
GCR, GNC and GBV instruments via a serial interface (either direct connection or via modem). Data 
retrieved from the instruments are stored on the PCs hard disk and can be reviewed and analysed later at 
any time. 
 
GeoDAS requires different amounts of computer memory and disk resources depending on how it is used. 
The minimum system however, should consist of least a standard Pentium II CPU, running Windows 
9x/2000/NT4.0/XP. The amount of RAM depends on the number of instruments maintained by GeoDAS at 
the same time, but must be at least 64Mb in any case. Hard disk space needed must be sufficient to store 
event data files arriving from the instruments and to maintain ring buffers of the active data streams. 
Standard serial communication ports are used to provide physical channels to the instruments. Depending on 
the configuration of recorders, additional multi-serial equipment may be required. Communication channels to 
the remote recorders may utilise different kinds of communication equipment, such as modems, telemetry 
channels, etc. 
 
It is recommended to set the display resolution to 1024x768 pixels minimum. ODV (Off-line Data Viewer) 
requires 65536 colours or more. 
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2 Application Installation  
GeoDAS is installed as many other Windows programs. In order to install GeoDAS, simply run the Setup 
program from an installation CD or from a diskette. The Setup program will guide you through a step-by-step 
installation process. 
 
If you have a previous version of GeoDAS already 
installed in your computer, you will be asked to select 
either quick upgrade or full installation. The quick 
upgrade ensures that all old settings will be kept for the 
new version of the program and therefore it is the 
recommended option. 
 

The installation mode of GeoDAS is chosen with the 
next setup screen. In most cases the "Normal mode" 
is the right choice. The monitor mode is used in 
special multi-computer configurations only. GeoDAS 
application installed as monitor can control other 
GeoSIG applications and can provide the general 
information about them to the subscribers by email 
an/or SMS messages. 

 
If a full installation is performed, the next screen will 
ask you to enter specific user information 
 

Please note that Off-line Data Viewer with the 
simple functionality is an integral part of GeoDAS. But 
the extended analysis functionality is provided as an 
option. A customer has to order it and receive a valid 
serial number, which must be entered during 
installation in order to enable access to the Analysis 
menu of GeoDAS 
 
Enter a Serial number if you have ordered the 
Analysis option or enter "0" if you have not ordered it. 
In such case, the Program will be installed as a "Light 
Version". Valid serial numbers are provided in the 
format xxxxx-xxxxxxxx. 
 
If you did not enter the Serial number or if you entered an incorrect code, the Analyse menu will be disabled 
and no single item of this menu can be accessed. You can also enter the correct serial number later at any 
time using Help->Registration menu. 
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Next setup screens will ask you to choose:  
• a destination directory, where the main executable program files will reside; 
• name of the folder, which will be created under Start->Programs menu to place a shortcut to GeoDAS 

there; 
• location of the GeoDAS home data directory. This directory will become a root data directory for all 

configuration files, all event data files, etc. This directory may differ from the one, where executable 
modules of GeoDAS are located. 

 
There are two options available for choosing in the 
very last setup screen: 

- Launch GeoDAS at startup. This option allows 
GeoDAS to be launched when Windows starts up. 

- Place a shortcut to GeoDAS on the desktop. 
This option, if selected, will place a program 
shortcut on the Windows desktop for your 
convenience 

 
 

 

 

 

 
Note: If you intend to use GeoDAS for the data acquisition utilising an ADC board, please make sure 

that all required drivers and libraries provided by the board manufacturer are installed correctly in the 
computer running GeoDAS. Please refer to the installation instructions supplied along with your board. The 
GeoSIG GSR-12PC recorders already have these drivers installed. 
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3 Getting Started 

3.1 Running GeoDAS. 

Running the GeoDAS is not different from running any other Windows application. Program can be launched 
from the DOS prompt typing the full program name at command prompt or by double clicking GeoDAS icon 
with the left mouse button in the Windows environment. After some seconds of initialisation, the main 
GeoDAS window will appear in the screen.  

GeoDAS application is intended to serve several standard GeoSIG instruments at the same time and 
therefore the most of information in all windows is presented as the lists of stations (instruments) indicating 
different parameters. 

3.2 GeoDAS Main Screen 

An example of the main GeoDAS screen is shown in the figure below. The figure indicates also the basic 
elements of this screen. 

At the top of main window you see the typical window menu - GeoDAS main menu. The main menu lists the 
basic categories of functions available: File, Edit, View, Analyse, Settings, Tools, Window and Help. All of 
them have pull-down submenus and all the references to items of submenus are given hereafter in the form 
“Main_menu_item/Submenu_item”, for instance menu item File/Exit quits the application. 

Data Streams Info Window

Channels Info Window

General Info 

Graph Data Monitor

Log Window

Context MenuStatus Bar 

Station Toolbar ODV ToolbarMenu Bar
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Besides of the pull-down menus, there are also context menus available in many list view windows. Right click in a 
window, and the corresponding menu will appear, if available. The content of such menu and the accessibility of its 
items depend on the current context: whether a parent window displays some information, whether it has at least 
one item selected, etc. An example of such menu is shown in the picture above for the window "Data Channels".  
 
There are two toolbars available in GeoDAS with the buttons for the main operations: Station Toolbar and the 
ODV Toolbar. With the first toolbar one can select a station from the list and perform the basic operations with 
selected station. If no station selected in the combo box of the Station toolbar then the first button initiates the 
procedure of Quick Login otherwise GeoDAS logs into the station, which is currently selected. The last button of this 
toolbar launches the Adding new station Wizard. The ODV toolbar has buttons for many operations of the Off-line 
Data Viewer. 
 
The Status Toolbar located at the bottom of main window displays important system messages, progress 
indicators for the operations, which take long time and some other status information. 
 
There are several information windows, which display various parameters of all the configured stations: general 
information, status of the data stream, parameters of the communication channels, etc. All these windows are 
described in the further chapters in more detail. 
 
The Logger window displays the latest system messages, which are saved also to the current GeoDAS log file. 
This window is opened first and always exists, irrespective to the current GeoDAS configuration. 
 
The Data Channels window displays current data signals arriving from the remote stations with the data streams. 
Many data channels can simultaneously be monitored with this window. 
 
Other elements of the GeoDAS interactive interface are many dialog windows, which are used to set different 
working parameters or to monitor some detailed information arriving from an instrument. 
 
Depending on its configuration, the GeoDAS may show some other information windows, such as Statistics of 
communication, Status of Applications. More detailed information is provided in the next chapters. 
 
When you start GeoDAS for the first time, you will see the Logger window only. No other information windows 
appear in the screen because you do not have configured any station yet. Therefore the next steps after the 
GeoDAS installation is to configure the stations you will work with and set parameters of the instruments. You have 
to go step by step through the following procedures: 
1. Configure the stations, i.e. make your instruments known to GeoDAS: Configuring the Stations 

2. Connect to every configured instrument to ensure that all communication parameters are correct 
and all instruments are accessible. Ensure that the settings of all instruments are set as required, 
otherwise adjust them with The Instrument Setup Manager 

3. Adjust parameters of GeoDAS, including those related to its extended functionality (if required), 
see The Other Capabilities of GeoDAS. 

The above steps are described further in more details. 
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4 Configuring the Stations 
The terms "instrument" and "station" are used in different context: 
• “Instrument” refers to the physical device type (such as “GSR-18”) 
• “Station” refers to a name given to a specific recorder/digitiser, installed at a specific location 
 One can upgrade an existing instrument without changing the station configured in GeoDAS. 
 

Every Station is identified by its unique name and every Instrument is identified by its unique serial 
number. 

4.1 Adding new station Wizard 
The simplest way of adding a new station to the current configuration of GeoDAS is to use the Wizard of 
Adding a New Station. Press the wizard 
button in the station toolbar and the 
following dialog appears.  
 
You may choose one of three ways of 
adding a new station. If you have only one 
instrument and it is connected locally to a 
serial port of your computer, the first option 
will be the best choice. In this case the 
Quick Login dialog will appear as soon as 
you press the button [Next >]. 
 
If you received your instrument along with 
a configuration file provided by GeoSIG, 
you may select the second option. Then you will be asked to select this configuration file with the next dialog 
called Adding new station(s) using the configuration file. 
 
The third option is for experienced users only but it provides the most flexible way of adding a new station. 
You can adjust parameters of communication channel and customise different work options of your new 
station. This is the only way to add a station, which is accessed through a dial-up connection, or to create a 
configuration with many different stations. More detailed information is provided further in the issue Adding a 
station manually. 

4.2 Quick Login 
The Quick Login dialog is used to log into an instrument, which is not yet exist in the current configuration and 
therefore it is used also while adding a new station to login to it and to gather its main, most critical 
parameters. In order to perform the quick 
login, one has to choose the correct serial 
port where your instrument is connected to 
and to enter the valid Password. Then 
press the [Login >] button. If this method 
is used to add a new station but the 
instrument connected to the specified port 
exists already in the current configuration, 
it will not be added. On the other hand, if 
this method is used just to login to a station 
but this station does not exist yet in the 
current configuration, it will be added.  
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4.3 Adding new station(s) using the 
configuration file  

New instruments are shipped usually with 
the configuration file attached. 
Configuration files have GSC extension. 
They are created during factory tests and 
they keep all parameters of your 
instrument along with the other default 
settings. Note that such file can keep 
parameters of several stations, which 
provides the efficient way of adding them 
to the GeoDAS's configuration. Select a 
communication port and the configuration 
file of your new instrument(s) and press the button [Next >] to complete the wizard. 

4.4 Completing the procedure of 
adding new stations 

This is the last dialog of wizard. It lists all 
new stations, which can be added to the 
current configuration. Note that GeoDAS 
assigns the default names to new stations 
added with the Quick Login method in the 
form STNNN, where NNN is the number 
from 001 to 999. If you would like to 
change these names, you can do it later 
at any time. You can also adjust other 
parameters of the new stations later as it 
is described in the issue Editing 
parameters of the configured stations. 
Press the button [Finish] to let GeoDAS be restarted and to complete adding the new stations. 
 

4.5 Adding a station manually 

The stations are configured manually 
with the dialog, which is launched either 
from the main GeoDAS menu 
(Settings) or from the context menu of 
the General Information window.  

The upper part of the dialog window is 
a list of already configured stations 
indicating the station name, type of 
instrument and communication channel 
and the operation mode. 

Below this list one can see the group of 
controls indicating eight steps, which 
must be performed in order to add a 
new station. 
1. Type the station name. Maximum 5 

characters. Station name must not 
have spaces or unprintable 
characters. 

2. Select the type of the configured 
instrument from the list of combo 
box. 

3. Enter the unique serial number of 
the main board of your instrument. 
The serial number is required for 
correct addressing of several 
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instruments connected to the same communication port. If it is not the case, you may leave just zero as a 
serial number. GeoDAS will replace this number with the correct one upon the first successful login to an 
instrument 

 
Please note that the serial number you enter is the unique instrument identifier provided when the 

instrument is shipped out to a client and it must be correctly indicated to GeoDAS, otherwise there could be a 
failure connecting to an instrument. Serial numbers from 1 up to 31 are reserved by GeoDAS for internal use. 
The serial number of an instrument has usually 6 digits. It can be found in the documents shipped together 
with every instrument. The same serial number is indicated also on the the yellow sticker of the main board.  
 
4. Enter a password. Please refer to the issue Password for more information. 
5. Confirm the password by entering it once again in the Confirm Password edit box. You can change the 

password later at any time with the Instrument Setup manager. 
6. Specify a communication channel to an instrument (button [Channel...]) 
7. Specify work options (button [Options...]) 
8. Now you can press the button [Add Now]. If all settings are correct, the station will be added to the list of 

configured stations. 
 

4.6 Editing parameters of the configured stations 
1. Select the station(s) you are going to configure in the list of configured stations 
 

To simplify the procedures working with several remote stations in the same manner, the program 
provides a possibility for multi-selection of the stations during setup, monitoring and while performing other 
operations whenever is possible. Therefore you can edit communication parameters and work options of 
several selected stations at the same time 
 
2. Right-click to activate the context menu and select the function: 
• Comm Channel - to edit parameters of the communication channel  
• Work options - to edit general options working with an instrument 
• Export to CSV - to save current configuration of the configured stations to a CSV-file (comma-separated 

values). This item is always available, even if no station is selected 
• Rename - to rename the currently selected station 
• Remove - to remove selected station(s) from the current configuration 
 

4.7 Password 

To prevent unauthorised change of parameters or misuse of the recording system (for instance, connected 
via modem to the public telephone line), the recording system needs a Password to initiate communication. 
The Password consists of a maximum of 8 characters; the program does not distinguish between upper and 
lower-case.  

Three levels of communication to an instrument are available for the operator. The level depends on the 
password being used for the Login. 

Login Level 1  
In this level the operator may only look at the status of the instrument and the parameters, it does not allow 
operators to make any changes. It is possible to retrieve data files, but not to delete any data. Default 
password: login001 

Login Level 2 
This level permits an access to all the operations, which are necessary to set-up and control the recording 
system; parameters may be changed and the memory may be cleared. Default password: login002 

Login Level 3  
This level permits all of the above function plus access to certain specific setup parameters. Default 
password: login003 
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4.8 Communication Channel Setup 

4.8.1 Types of communication channels 

GeoDAS can work as a central station for several local and/or remote instruments. Every station has a serial 
communication interface and can be accessed through different types of serial channels. Depending on the 
tasks performed by the instrument, the following general options can be used: 
• Simplex channel (instrument to GeoDAS only, data steams from locally configured instruments) 
• Half-duplex channel (typically UHF telemetry, GSM SMS (Short Message Service), RS-485) 
• Full-duplex channel (direct or modem link, including spread spectrum radio modems) 
Instruments may have dedicated physical channels to GeoDAS, which provide a possibility to support 
permanent data streams. Instruments working as recorders only do not require to have dedicated channels. 
Setup of the recorders, monitoring of their State of Health (SOH) and downloading of the event files may be 
performed from time to time through shared channels like modem telephone lines. 

In some cases several instruments can be accessible through the same physical channel at any time, for 
instance, while using telemetry radio channels.  In order to access several instruments through the same 
physical serial channel, the procedure of login into an instrument uses a unique four-byte serial number of an 
instrument along with the password. This approach assures responding to a request only from an instrument, 
which has the requested unique serial number.  

In all cases GeoDAS must be given information about serial channel(s), which can be used to access every 
configured station. 

Click the [Channel...] button to setup communication channel (when adding a station) or choose "Comm 
Channel..." from the pull-down menu to launch this procedure for a configured station. 

The Communication Channel Setup window will appear: 

 
First of all, select the type of communication channel. It can be one of the followings: 
1. Direct link through a dedicated serial port. This type must be used if your instrument is connected with the 

RS-232 serial cable or it is accessible through a radio telemetry link, spread spectrum radio modem, etc. 
The port number must be selected from the list. 

2. Dial-up link through dedicated modem. Connection over a telephone line. The same modem is always 
used to connect to the station, which is configured. This type of connection also requires a serial port to 
select. 

3. Shared Modem. Connection over a telephone line. But the modem is selected from a group of modems 
(modem pool). Each time the link must be established, GeoDAS searches for the first idle modem in the 
pool and uses it to establish the connection. 
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4.8.2 Modem pools 

In order to configure a connection using the shared modems, you have to specify first one or several modem 
pools. Simply press the button [Configure Modem Pools...] and the following dialog will be launched: 
 

You can enter the name of a new modem pool in the edit box and then press the button [Add Pool] to add it 
to the list of configured modem pools. If you select a modem pool from the list, you can: 

a) Remove this modem pool from GeoDAS configuration by pressing the button [Remove]; 

b) Rename it. Enter a new name in the edit box and press the button [Rename]; 
c) Configure modem pool. Ports, which are included already to the pool, are listed under "Ports 

assigned to the pool". The rest of available ports are called "Free ports available". Use the 
corresponding buttons to add/remove ports. Buttons "Up" and "Down" arrange the order of access to 
the ports. 

Furthermore, there are three options available in this dialog. They are applied individually to each configured 
pool. 

• This pool consists of GSM modems. This option must be checked if the modem pool consists of GSM 
modems only. 

• Modems of the pool receive incoming calls. If enabled, this option instructs GeoDAS to monitor 
incoming calls, which can be made by the stations configured to dial out on events. 

• Modems of the pool can send and receive SMS. Makes sense for GSM modems only. Please note 
that not all GeoSIG instruments support SMS messages. 

As soon as you have all the required modem pools configured, press the [OK] button to save the current pool 
configuration or [Cancel] to discard all the changes you have made and return to the Channel Setup dialog. 

If you configure a channel type as the one provided with a shared modem, you have to select the name of a 
primary modem pool from the list. GeoDAS provides also the possibility to use a secondary modem pool for 
this type of communication. This allows the communication strategy to be configured in a more flexible way, 
for instance, one modem pool can be assigned to receive incoming calls and the other pool can be used for 
dialling out only. In any case the modems are requested by GeoDAS from the secondary pool only if all the 
primary channels are busy. 

4.8.3 Other communication parameters 

• Default baud rate specifies initial baud rate of the communication channel. GeoDAS tries first to connect 
to an instrument at this baud rate. 

• Try all the baud rates supported. If an instrument does not respond at the default baud rate and if this 
option is enabled, GeoDAS will try the other baud rates until it gets connected to an instrument. Available 
baud rates are: 1200, 2400, 4800, 9600, 19200, 38400, 115200  

• Ready to send latency is a parameter, which is important in case of half-duplex radio channels. It 
specifies the time interval in milliseconds, which is required to switch the radio modem from receiving to 
transmitting mode. 
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The group of parameters called "Modem Specific Settings" includes various options, which are valid for dial-
up communication channels only: 

• Telephone number of the station. Note that the default dial mode is TONE. In order to dial a phone 
number in the PULSE mode, simply insert the prefix ‘P’ before the phone number, e.g. P167924. 

• Modem initialisation string is sent to a modem every time while establishing a connection to ensure the 
proper initialisation of all modem parameters. Typical components of this initialisation string are as 
follows: AT - gets the attention of the modem, it is leading to every command string; &F - restores factory 
defaults; E0 - disables the modems echo mode. For more information refer to the User Manual of your 
modem. 

• Hang Up string is sent to a modem to hang up the telephone line (for Hayes compatible modems: 
ATH0). This sequence of commands is used to hang up the telephone line only if the link has been 
interrupted unconventionally. Usually GeoDAS hangs up the line automatically after a Logout.  

• Connect timeout is a maximum time interval (in seconds) to dial a telephone number and to establish a 
connection to the remote instrument. 

• GSM modem checkbox instructs GeoDAS to use an extended set of AT-commands for GSM modems.  

Please make sure that the PIN code protection of your SIM card is disabled prior to use this card with a 
GSM modem. 

• Support for SMS. This option is valid for GSM modems only. It allows many short messages like setup 
commands or SOH reports to be transferred in the batch mode using SMS. In order to use the SMS 
service, the telephone number of your SMS Centre must be saved in the SIM card. Usually it is done 
already when you purchase a subscription from the provider. But in case the SMSC number is not yet set, 
you have to do it manually by using any cellular phone. 

Note that not all GeoSIG instruments and not all the firmware versions support currently the specific 
options of GSM modems, including extensions for SMS communication. Please refer to the User Manual of 
your instrument to check whether it is compatible with GSM modems. 

• Use separate modem pool for SMS. Since an SMS message can arrive at any time, even when dial-up 
communication is established, it might be reasonable to have different modem pools for receiving of 
normal calls from the remote instruments and for receiving of SMS messages. You can specify such a 
pool with this option. 

• Send SMS to the other phone number. Very often the SIM card may have different phone numbers for 
the voice calls and for the data transfer. If you use such a card in the GSM modem of your instrument, 
you have to enter here the voice number of the SIM card. The number entered as a "Station phone 
number" must always be the data number. 

• Modem receives incoming calls. This option applicable to all the dial-up channels and it allows the 
incoming calls from the stations to be received. In order to make such calls the instrument must be 
configured to dial out on every new event. See the issue Communication Parameters for more 
information.  

Note that if you are configuring not a dedicated dial-up channel but a modem pool, then the options "GSM 
Modem", "Support for SMS" and "Modem receives incoming calls" are set while configuring the modem pool, 
not in this dialog. 
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4.9 Work Options 

Press the [Options...] button (when adding a station) or select "Work Options..." from the context menu of 
the station list to set or adjust the various station options. 

The Work Options dialog will appear: 

 
Work options specify the set of parameters, which determine the strategy of GeoDAS operation. They are 
grouped according to their functionality:  

The group "Periodical Check-up of the Instrument" specifies whether GeoDAS must login periodically to 
the current station in order to check its status and download event files, which might have been recorded. If 
check-up is enabled then you have to specify how often and at which time it is performed. You can also 
instruct GeoDAS to retry automatic login in case of any failure. In this case the number of logins and 
interval between them must be set. In case of the permanent check-up, every next login to the instrument 
is performed in several seconds after logout. This mode is not recommended for the dial-up and shared 
communication channels. If neither periodical nor permanent check-up mode is selected, GeoDAS will never 
initiate a connection to the instrument for a status check. 

The group "Data Stream Options" tells GeoDAS whether the data stream must be received for the current 
station. Please note that only GBV, GSR-24 and some versions of GSR-18 instruments provide data 
streams. The instrument must be configured to send data through the serial channel. You can find more 
information about the data streams in the chapter Working with Data Streams. 

• Acquire data from the stream, if enabled, instructs GeoDAS to perform the required actions in order to 
be ready to receive data blocks from the instrument through a serial communication channel. 

• Request for the data packets. Some instruments can be set to a mode in which they send data packets 
by request only. It means that GeoDAS is fully responsible for the timing of such requests but on the 
other hand it gives the possibility to receive several data streams from different instruments through the 
same communication channel (Point-to-multipoint configuration). 

 

If your data acquisition system consists of several instruments, which provide data streams in the packet 
request mode, you have to make sure that: 

1. All instruments connected to the same communication port can provide data streams 

2. All instruments have been set to communicate with GeoDAS at the same baud rate 

3. All of them support the "data streams by request" option and this option is enabled 
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4. The number of instruments at the same port, the number of channels in the data streams, their sampling 
rates and the communication baud rate are selected in a way that one-second data packets from all of 
these instruments can be delivered to GeoDAS within one second. 

 

• Data Simulation. One can simulate data packets by selecting the simulation option. This feature is 
provided mainly for debug and training purposes. Two types of simulation are supported by GeoDAS: 
either data packets are simulated internally or they are sent out through the serial port to be received 
further by another serial port, as they would arrive from the real instrument. In both cases the software 
signal generator creates the signal. The generator has several channels and you have to select one of 
them from the list. Parameters of the signal can be adjusted. Press the button [Simulator Settings...] 
and the following dialog box will appear 

 
You can set here the following parameters of the ten channels: 
1. Signal type can be one of “Sine Wave”, “Square Wave” or “Noise”, which is selected from the list; 
2. Signal frequency can be set to any positive reasonable value. This parameter is not used for the 

signal of type "Noise"; 
3. Amplitude of signal must be specified in interval [0 - 1.0] relative to full scale, which is equivalent to 

1.0. If the instrument delivers three components (x, y, z) through the data stream then the amplitude 
of second component will be only ½ of the first one and the amplitude of third component – ¼ of the 
first one; 

4. Phase of the signal must be specified in units of signal period (not used for the "Noise" type); 
5. Event Amplitude is specified by a multiplication factor to the normal amplitude between events. If you 

do not need to generate simulated events, set this parameter to 1.0; 
6. Event Duration and the Event Interval (time interval between events) are set in seconds.  
 
Press the [OK] button to save all changes you made and dialog window will be closed after data 
validation. 
 

When you press the [OK] button in the dialog window, GeoDAS validates all data in all list boxes 
before taking them into current configuration. This process may take some time and you can see the 
message in the status bar of the main window "Validating data…" 

The group “Download Parameters”. One can specify here whether every new event must be downloaded 
automatically upon the connection to an instrument. If the file with the same name exists already in the local 
event directory, one can either skip downloading it or one can overwrite it in any case - this option is also 
specified here. Finally the file can be deleted from the instrument as soon as it is downloaded successfully or 
it can be left in the instrument memory. One can also specify the local event directory other than it is 
suggested by default. But it is not recommended since GeoDAS searches for the event files in the special 
subdirectories of its home data directory, which makes a problem to find a file in a directory other than the 
default one. Therefore in most cases the best choice is to leave the word “Standard” (or "default") as the 
directory name. GeoDAS will select the default directory to story event files. 

Last group of the options: “Miscellaneous”. The following options are listed here: 

• Login to single instrument. This option, when selected, forces single login to an instrument without 
use of its serial number. Must not be applied in multi-instrument configurations, when more than one 
instrument communicates through the same direct serial link.  
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When you replace your instrument with a new one, but the station record is left the same in 
GeoDAS, the option "Login to single instrument" MUST be enabled upon the first login to the new 
instrument. Otherwise GeoDAS will try to login using the old instrument number and this will never be 
successful. As soon as GeoDAS has logged once in to the new instrument, the new serial number is 
retrieved and this option can be disabled again. 

• Declare an error if no AC … Usually the loss of AC power is not considered as an error because 
instruments are equipped with a battery and can work from this battery during the long time interval. 
But if this option is set then GeoDAS declares an error upon login to the instrument if the specified 
time interval (in hours) since last power loss is elapsed. This situation is processed by GeoDAS as 
any other instrument error, i.e. indicated with the red point in the list of stations, logged to the protocol 
file, reported via messaging system, etc. 

• Synchronise instrument time with the computer time. This option is used rarely and can only be 
enabled in the permanent check-up mode. The instrument time is synchronised with the computer 
time upon every login. 

• Connected to the annunciator… This option is used in the special applications only, when several 
instruments are physically connected to the special device, GeoSIG annunciator. Refer to the 
Instrument Setup Manager page Annunciation for more information about annunciation options. 
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5 Configuring the Instrument  
It was described in the previous chapter how to configure the Station, i.e. how to make your instrument 
known to GeoDAS, how to establish a link to the instrument by means of the different types of communication 
channels and how to adjust a strategy working with it. Now it is time to know how to set the parameters of an 
instrument, how to adjust all the settings according to which your instrument will work even without being 
connected to the computer. This is the job of the Instrument Setup Manager. 

5.1 The Instrument Setup Manager 

As soon as a station is configured and the program is restarted, the Instrument Setup Manager becomes 
accessible through the context menu of the main General Information window. Select a station from the 
General Info list and either click the item Instrument Setup of the context menu or push the second button 
on a Station toolbar.  The following dialog will be launched: 

 

As one can see from the picture, the Instrument setup window consists of two parts. On the right hand side, 
several control buttons are located, whereas the left part is a set of information pages or 'tabs'. They are filled 
up with the detailed information stored in the instrument. The following pages are available: Station, 
Instrument, Sampling, Channels, Date and Time, Data Streams, Communication, Interconnection, Event 
Trigger, Time Triggers, Error and Warnings, Test, Power and Batteries, Alarms, Printer, Batch Mode, LCD 
Display. 
 
All setup instrument parameters are grouped into the pages according to their functionality. The set of pages 
is always the same. But the way in which every particular page looks depends on the type of instrument. If an 
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instrument does not use some parameter or some option is not supported, the corresponding dialog control 
(like edit box or check box, etc.) can be either disabled or hidden (invisible).  
 
Some instrument parameters are read only, they cannot be edited but displayed only: the internal instrument 
counters, statistical data, etc. They are placed usually to the read-only edit boxes. 
 
When you change some parameter and then try to switch to another page, the settings of the current page 
are checked first for correctness and if some parameter is found incorrect, you cannot change the page 
before you enter this parameter within the expected range. 
 
Some buttons are enabled if on-line only, i.e. GeoDAS is logged in to an instrument. Otherwise they are 
greyed and the corresponding actions cannot be performed. 
 
Please note that when sending the updated parameters to the instrument in on-line mode, it might not accept 
some of them because of the following reasons: 

- a parameter is not within the range, available for the current type of the instrument; 
- your login level is not high enough to run some particular command; 

When you are on-line, the current login level is indicated in the Communication page. The 3rd level 
is the highest, which allows you to change every parameter. 

There can be also other problems running some instrument commands. Therefore always verify whether 
specified parameters are really updated in the instrument. If you see that some parameter has changed its 
state to the initial one after update, it means that the parameter is not accepted. In case of some failure an 
error or warning message appears usually in the Log window.  

5.2 The Control Buttons 

It is important to understand that in general there are two sets of instrument parameters you operate 
with GeoDAS. There are real parameters, which are kept in the instrument, and there are '"off-line" 
parameters, which are downloaded from the instrument upon the last login and which are kept locally in the 
setup file(s). If you are logged into the instrument currently then the real parameters are reflected in the 
information tabs of the Instrument Setup Manager. Otherwise the off-line set is displayed. 
 
The content of the setup pages is fully updated upon the login to an instrument or when logging out from it. 
While logged in, only those parameters, which can be changed by instrument at any time, are updated 
permanently. But if you like to update the whole current page with the actual instrument parameters, simply 
press the button [Refresh] to do so.  
 
Next buttons are used to send parameters to the instrument, 
either those shown in the active page ([Put Page]) or all 
parameters from all the information pages ([Put All]). In any 
case the parameters to be sent out are validated first and then 
they are compared with the real instrument parameters. If no 
single difference is found, the following dialog box asks user to 
select the further action. You can either cancel operation 
answering "No" or all the parameters will be updated regardless of difference between the existing 
parameters and those, which are sent. 
 
If you try to update all 
instrument parameters 
and if GeoDAS has 
found at least one 
parameter of the Setup 
Manager, which does 
not match the same 
parameter in the 
instrument, you will be 
asked to confirm the 
update. As always, 
[Yes] and [No] are the alternative answers. Pressing [Cancel] button will cancel the operation. If you select 
[Yes to All], then all modified parameters will be sent to the instrument with no more questions. If, in addition, 
you select an option "Always confirm", then no more questions of confirmation will be asked until the current 
session ends.  
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The [Reset] button performs a software reset of your instrument. This is almost similar to switching it off and 
then on again. Please note that not all instruments support the software reset. You have to confirm the action 
by pressing [Yes] in the following 
dialog. If you select the option 
"Reinitialise..." then all the 
current parameters will be lost 
and replaced with the default 
instrument parameters. This 
operation is applied very seldom, 
only in case of serious troubles. If 
you are not familiar well with the 
instrument setup parameters, it is recommended to save the parameters first to a file (see the Export 
operation further) prior to this operation. As soon as reset is done, you will be logged out automatically. Wait 
for some seconds until instrument performs all the restart operations and connect to it again. All setup pages 
will be filled up with the default instrument settings. 

The [Export] button provides a possibility of saving the current set of parameters to a configuration file. You 
can specify the name of a configuration file, which can be placed to any local or network directory. At any 
time you can download these parameters to the configuration pages of Setup Manager with the button 
[Import]. 

Besides of the buttons described above, there is also a button, which is used to [Exit] from the Instrument 
Setup Manager and there is a button to log in ([Connect]) to the instrument or to logout from it. 
The status line below the information pages indicates briefly the current status of the station. The contents of 
information pages are described below in more details. 
 
If the Instrument Setup manager is launched from the Context Menu of the General Information Window in 
the Batch Multi-Setup mode, the buttons [Refresh] and [Put Page] are replaced by the buttons [Get By 
Batch] and [Set By Batch]. These buttons are used to get or set parameters of the current page with batch 
requests.  
One more button [Delete All] becomes available in this mode. It is used to delete all files from the selected 
instruments by sending the corresponding batch command. 
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5.3 Station Parameters 
The most of the parameters of this page are related to the place where an instrument is installed. Here you 
can assign a three-letter code to a station, enter the name of its location and coordinates, including altitude. 
 
The Station code can be a 
combination of any three 
characters. They are 
indicated in the General 
Information window as the 
station identifier along with 
the station name. But the 
code is kept in the 
instrument, whereas the 
station name is known to 
GeoDAS only. It might be a 
good idea to set the station 
code as three last 
characters of the station 
name. In such case the two 
first characters can be the 
code of a local seismic 
network. This naming 
convention is used very 
often for seismic stations. 
 
The Location is usually the 
name of a place where the 
instrument is installed. 
 
Latitude, Longitude and 
Altitude identify the 
geographic coordinates of 
the instrument's location. If 
the instrument has GPS 
receiver connected, one can set these parameters from the GPS information, which is indicated in this page 
as well when the receiver provides correct information. Simply press the button [Update from GPS] to do so. 
If there is no GPS available, one can enter the coordinates manually in the following format: 
• Longitude: DDD MM.MMML, where DDD - degrees, MM.MMM minutes with thousands, L - must be 

either W (West) or E (East);  
• Latitude: DD MM.MMML, where DDD - degrees, MM.MMM minutes with thousands, L - must be either N 

(North) or  S (South); 
• The altitude is entered in meters, 6 characters maximum. 
 
Number of Restarts is also indicated in this page. You can reset it to zero by pressing the button [Reset 
Restarts Counter]. 
 
When the instrument is installed, it is recommended to enter and save the Date of Installation in the 
corresponding field. 
 
We recommend also updating the Date of Last Check and the field Checked by on every inspection of the 
instrument. 
 
The field Comment can be filled up with any comment string, which does not exceed 50 characters. 
 

If you have modified some parameters and would like to save them to the instrument, do not forget to 
press the button [Put] to do so. 
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5.4 Instrument Parameters  
The parameters of this page indicate general information about the instrument itself. If they are greyed, they 
are not editable.  
 
The Instrument Type and 
the Manufacturer indicate 
which type of Instrument is 
connected. 
 
The information on 
Firmware Version might 
be important in case you 
ask for any kind of 
technical support at 
GeoSIG. Be ready to 
provide the information 
about your firmware 
version. 
 
GSR-18 has a digital signal 
processor on board with its 
own software. The version 
of its DSP Firmware is 
indicated here too. 
 
Main board S/N is the 
serial number, which you 
enter normally while 
configuring a station but 
this page indicates the 
correct number retrieved 
from the instrument upon 
the first login. The number 
is indicated on the main 
board (yellow sticker). 
 
The group Memory Info contains read-only information about Memory Type, Total amount of memory and 
amount of memory used by data files. The physical storage for the event files is usually the Compact Flash 
ATA card with a capacity up to 64 MB or even more.  
 
The RAM Structure is also indicated here. RAM is a fast memory, which is used by the micro controller to 
keep various parameters, temporary data, etc. Part of the RAM is used to keep the last several seconds of 
data acquired from the sensor. In case of an event is declared those data blocks can be saved to the event 
file as a pre-event section. Thus the amount of memory for the pre-event data is limited by the dedicated 
RAM size, which means that also the pre-event time has an upper limit. 
 
The option Create One-channel Data Files supported by the few firmware versions only. Enable this option 
if you would like to keep only the first component of the signal in files, even if your instrument has a three-
component sensor connected. 
 
The group Peripherals specifies which devices are connected to your instrument: Analog or GSM Modem, 
CDPD Modem, GPS, Serial Printer. Only GSR-12/16 and GCR instruments support serial printer. Note that 
the serial printer and GPS receiver cannot be used at the same time. Only GT-316 instruments currently 
support CDPD Modem option. 
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5.5 Sampling Parameters 

Sampling Rate is the most important parameter of this page. The sampling rate can be set to 25, 50, 64, 
100, 125, 150, 200, 250, 400, 500, 800, or 1000 samples per seconds. Not all the listed sampling rates are 
available for every type of instruments. 
 
Therefore, please, refer to 
the instrument's manual to 
check for available sampling 
rates for your instrument. 
 
DC Drift compensation 
corrects any permanent 
offset of the sensor signal.  
The speed of drift 
compensation depends on 
the instrument type. 
 
Zero level of the signal can 
be adjusted with the button 
[Correct the Baseline]. 
 
The other button, [Reset 
Real time Peaks] is 
available for GSR-18 only. It 
can be used to reset the 
peak values of velocity, 
acceleration, displacement, 
which are permanently 
calculated by the DSP. 
 
The other group of controls 
called Monitoring of the 
Real Data displays the 
tables of current samples 
and peak values. Please 
note that the peak values are available for GSR-18 instruments only. The Response Spectrum Acceleration 
or Displacement (RSA or RSD) is always calculated at several frequencies. You can watch these values at 
any available frequency by selecting it from the list Frequency of RSA peaks.  
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5.6 Parameters of Channels 
This page indicates the main parameters of the channels and the sensor scales. 
 
Generally, three different 
gains can be set for the 
sensors with GeoDAS. You 
can select the desired gain 
from the list Selected Gain. 
But only few sensors 
support different gains, for 
the others the Gain1 is 
always used, which must be 
indicated with the option 
Gain1 is always selected. 
 
The actual number of 
Instrument channels and 
the ADC resolution are 
also indicated in this page. 
 
Main channel settings are 
summarised in the table. 
The number of rows in this 
table corresponds to the 
number of channels and can 
be 1, 3 or 4 (GCR 
instruments).  
 
You can set the following 
parameters for each 
channel: 
• Name of the channel 
• Name of the physical 

units (typically g for 
accelerometers and 
mm/s for 
seismometers). This parameter is selected from the list, except for the sensor type Custom: in this case 
you can enter up to five any characters, which will be used as a unit name. 

• Sensor type selected from the list as it is shown in the picture. 
• Full scale of the sensor (separately for each of three gains) 
• Axis direction (positive or negative, i.e. inverted) 

Please note that GeoDAS cannot verify whether all parameters are entered correctly for some types of 
sensors. Therefore always refer to the manual of your sensor to set the correct value of its full scale. 

Full scale values and the unit names can be changed freely for the sensor type "Custom". Actually it can be 
any type of sensor and the user takes responsibility for the correct input of its parameters. All other types of 
sensors have fixed pre-defined parameters. As soon as sensor type is selected from the list, gain values and 
unit names will be set automatically. 
 
Refer to the Appendix A. Information on LSB for more information about Full scales of the sensors and LSB. 
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5.7 Date and Time 
All the time-related instrument settings are located in this page.  Three current dates and times are displayed: 
Recorder time (as it is set in the Real Time Clock of the recorder), PC time and the GPS time (only if GPS is 
connected and provides 
valid date and time).  
 
All time stamps of the 
event files, reference time 
of the data streams, etc. is 
taken from the real time 
clock (RTC) of the recorder 
and therefore it is 
important to ensure that 
this time is correct. The 
best way of setting the 
correct RTC time is to use 
the GPS receiver. If it is 
connected and provides 
the valid information, you 
can update RTC with GPS 
time by pressing the button 
[Update from GPS]. 
Usually the instrument 
performs this procedure 
automatically. 
 
If the RTC time is not 
required to be very precise, 
you can also update it from 
the computer real time 
clock by pressing the 
button [Update from PC 
RTC]. 
 
You can also enter your custom date and time in the fields Custom and press the button [Update from 
custom settings]. One can always see when the instrument RTC was updated last time: it is indicated under 
the Last Update label. 

The group GPS Status and Control displays information about GPS status and its mode of operation. The 
GPS receiver can be switched on continuously or periodically. The last mode is preferable if the instrument is 
powered from battery because of the high power consumption. In this mode the GPS is turned on every 
several hours and remains on until either the maximum time interval of staying switched on is elapsed or the 
GPS gets locked and the RTC is updated. All these parameters can be adjusted with the controls of the 
group GPS Work Mode. 
 
There is also a button, which can be pushed at any time to [Disable GPS] or to enable it again. It is also 
recommended to [Initialise GPS] after the first power on of the instrument. 
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5.8 Data Streams Parameters  
This page contains several parameters for the serial data streams. They are valid only for the instruments, 
which can provide data streams. Two types of data streams are supported. The standard stream of samples 
or packets is delivered through the main serial communication channel, which is normally used to login to the 
instrument. 
 
The other type of stream is a 
stream, which is in IASPEI 
format (International 
Association of Seismology 
and Physics of the Earth's 
Interior), and which is sent 
out through the optional 
additional serial port of the 
instrument. Not all 
instruments support this kind 
of un-interrupted stream. 
 
The standard stream can be 
either enabled or disabled 
with the option Enable 
Serial Data Output. One 
can set also the type of the 
serial output (either Stream 
of packets or Stream of 
samples).  
 
The data packets can be 
sent either every second or 
by request from GeoDAS 
only, which is indicated by 
the option: Send data 
packets by request only. 
This functionality was 
already described in the 
issue Work Options 
 
Some 3-channel instruments can provide one-channel data stream. If you would like to enable this 
functionality, tick the point at One Channel radio button. 
 
Two options can be set for the IASPEI stream if it is supported: you can specify which synchronisation 
character must be used and the sampling rate at which the data are provided. 
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5.9 Communication Parameters 
The parameters of this page specify the most important communication settings. You can change, for 
instance, the Baud rate by selecting it from the list. As soon as you apply the new baud rate by pressing the 
button [Put], the next command will be performed at the new baud rate. 
 

Before selecting a high 
Baud Rate such as 38400 
or 115200 Baud please 
verify that the computer is 
able to communicate at that 
speed and the channel 
supports it physically.  If you 
have changed baud rate to 
a higher value but the 
quality of link is not enough 
to communicate at this 
speed, you will not be able 
to connect to the instrument 
anymore. You will have to 
connect with a short serial 
cable to change the baud 
rate back to the appropriate 
value. 
 

The Baud Rate can not 
be changed if the recording 
system is communicating 
via modem. Usually baud 
rate is fixed at 38400 baud 
for the modem connection. 
To change it, you have to 
disable first the option 
'Analog Modem' in the 
Instrument page. GSM 
modems communicate 
usually at 19200 baud. 
 
Disconnection timeout specifies the maximum time interval to keep an operator logged in without 
communication to the instrument. On elapsing this time the instrument performs automatic Logout. If it is 
required to keep GeoDAS logged in to an instrument permanently, the value 255 has to be used as 
disconnection timeout. But this approach does not work for the dial-up channels. 
 
Data block size is not yet supported by all GeoSIG instruments. You can specify the block size for the event 
transfer between 256 bytes and 4Kbyte. The bigger the block size the faster the transfer. But if the serial 
channel is not reliable and there are many errors during data transfer (i.e. many blocks have to be resent) it 
might be better not to use the biggest available size of the data blocks. 
 
The group Modem Settings contains the modem specific parameters such as Initialisation String. Please 
refer to the user manual of your modem to set the optimum modem parameters in the initialisation string. If 
Enable AutoDial on event is selected, the instrument will call back as soon as a new event is recorded. 
Please make sure that GeoDAS accepts this call by setting the corresponding option in the Other 
communication parameters while configuring the station channel. The telephone number must be specified in 
the AutoDial string as it is shown in the picture above. When GeoDAS receives such a call, it logs in to the 
instrument and can download the new event, if the automatic downloading is enabled.  
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The last group of controls is intended for an instrument password change. You can enter the new password 
with confirmation in both on-line and off-line mode. As soon as it is entered, press the button [Change 
Password]. If you are staying off-line, the password will be changed locally and it will be used next time to 
login to an instrument. When connected to an instrument, the current valid password is known to GeoDAS 
and therefore it must be entered for verification along with the new password and with its confirmation.  
Pressing a button [Change Password] in on-line mode causes the password change not only locally but also 
in the instrument. 
 
 
 
 
 
 

5.10 Interconnection Parameters 
Some Instruments can be interconnected in a local network and the one, which is set as master, provides 
synchronisation signals for the other instruments. All network options are on this page. 
 
If you would like to use the 
interconnection options, you 
have to Enable Network 
Synchronisation first. 
Then the other options 
become available. They 
specify whether the 
instrument works in a 
Network Master Mode, 
whether it issues a network 
trigger signal (Output 
Network Trigger) or it 
receives the signal from the 
network (Input Network 
Trigger). You can also 
Synchronise Slave Clock 
to Network Clock by 
selecting the corresponding 
option. 
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5.11 Event Trigger Parameters 
All triggering options can be found in this page. They define the strategy of the event recording and therefore 
it is one of the most important pages of the Instrument Setup Manager. 
 
Two main types of 
triggering algorithm are 
supported: level trigger and 
STA/LTA based trigger. 
Beside of that, the trigger 
can be initiated by a 
software command 
(Manual Start/Stop), by 
the external signal 
(Hardware Trigger) or it 
can be issued based on 
some predefined date/time 
(Time Based Trigger). 
Last three types of 
triggering can be either 
enabled or disabled by 
ticking of corresponding 
checkboxes.  
 
Level trigger and STA/LTA 
based trigger can be 
enabled or disabled 
channel-wise. Set 'Yes' or 
'No' in the table to enable or 
disable those types of 
triggers. The level triggers 
have individual thresholds 
for each channel, whereas 
the STA/LTA triggering 
algorithm has the same 
parameters for all 
channels. They are: 
• STA interval in ms; 
• LTA interval in seconds; 
• STA/LTA threshold ratio in dB; 
• Update LTA: whether LTA calculation must be clamped during the event recording. 
 
Every event waveform is recorded with some additional parts before a trigger is declared and after de-trigger 
is declared as it is specified by the corresponding parameters (Pre-event time and Post-event time). In 
order to let the instrument stabilise its work parameters, the triggering algorithms do not issue a trigger within 
Turn-on delay time interval after the instrument is turned on or restarted. 
 
To reduce false triggers, one can select also an option: Use trigger Bandpass filter, which is available for 
GSR-18 instruments only. 
 
Software trigger can be initiated by pressing the button [Start]. The same button is used to de-activate the 
software trigger. Current status of the trigger is also indicated in this page 

A user cannot deactivate the GBV software trigger. Once it is initiated, it will last as long as pre-event 
plus post-event settings (seconds) 

 
The button [Edit] brings you to the Time Triggers page. 
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The "Event Trigger" page 
for GCR instruments looks 
different. This is mostly 
because GCR instruments 
support two types of event 
files: event records (ER) 
and permanent records 
(PR). PR are not really 
events, they contain peak 
values of the signal within 
predefined time intervals 
Tact Rate, which are 
monitored within Monitor 
Period for every permanent 
record. 
 
Permanent recording, if 
enabled, can be performed 
either always or according 
to the GCR timetable.  

Event recording, if enabled 
with Enable ER option, can 
also have different options 
as it is specified by the 
corresponding controls: 

• Single event. This 
mode is used in 
combination with the 
permanent recording. It 
will record only the highest peak event within a permanent recording period. Status of the event trigger 
indicates ER: RDY when the instrument is ready to trigger in this mode. 

• Level triggered events. This mode will enable the event and permanent recording to record all events 
based on the trigger thresholds specified in the table. 

• Level triggered and time based events. This mode will enable event and permanent recording to 
record all events based on the set trigger level but will record only during the Time and Date period, 
which is set in the Time Triggers. 

 

Other GCR specific parameters: 
• Autodelete event 
• Max duration of the event, seconds 
• ER and PR will save only those components to the files, which are specified in the table in the 'ER Save' 

and 'PR Save' columns. 
 

The buttons [ER] and [PR] indicate the recording status and can be used to start or stop ER and/or PR 
correspondingly. 
 
The current status of both recording types is indicated under the "Status of event trigger": it can be one of the 
followings: 
- REC - recording; 
- RDY - ready to record; 
- DIS – disabled; 
- OFF – recording is not possible. 
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Some types of GSR-18 
instruments (firmware 
versions 02.04.xx) require 
special settings of event 
trigger parameters. They do 
not support event trigger 
based on STA/LTA ratio, 
only level trigger. It is 
possible to set trigger 
thresholds independently for 
every component of the 
signal. These instruments 
can monitor two trigger 
levels: low level is used to 
declare the event and to 
start recording (which is 
always enabled) and the 
high level is used to 
generate an alarm. 
Therefore the "Event 
Trigger" page is simplified 
for this type of instruments 
and both trigger levels are 
set in the Alarms page. 
 
The other specific feature of 
these instruments is the 
improved trigger bandpass 
filter 0.1…31.5 Hz, which is 
always enabled. 
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5.12 Time Triggers  
The timetables for the time-based triggers are different for GBV, GCR and GSR instruments. GeoDAS 
supports all three types of timetables and all of them are shown in this page. 
 
GBV has the only 
predefined Trigger date 
and Trigger time but the 
trigger can be performed 
as many times as specified 
either Starting from the 
trigger date and time or 
Daily at the indicated 
time. There is also one 
more option available: 
Trigger continuously 
until the memory is full. 
The duration of every 
record is set in the 
Duration field in seconds. 
 
GCR time trigger can be 
performed only once a day 
but one can set the Start 
and End date as well as 
the Start and End time as 
it is indicate in the middle of 
the page. 
 
GSR time triggers are most 
complicated. One can set 
up to four trigger dates 
and times, specify the 
duration of event and how 
many times the trigger 
must be activated (in the last column of the table). Trigger repeat interval can be set in a flexible way: from 
several seconds to several days. To de-activate one or more GSR time triggers, simply set its duration to 
zero. 
 

If you are going to use the time triggers, do not forget to enable the Time Based Trigger option in the 
Event Trigger Parameters. 
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5.13 Errors and Warnings  

This page does not contain 
any changeable parameter. 
It just indicates the current 
status of errors and 
warnings as it is specified 
by the legend of indicators. 
 
When staying connected to 
an instrument, one can 
reset all errors and 
warnings by pressing the 
button [Clear Errors and 
Warnings]. But if the 
reason for an error is not 
eliminated, it will appear 
again either immediately or 
after some time. Some 
errors end warnings are not 
monitored permanently; 
they can be detected 
during the instrument test 
only. Refer also to the page 
Test Parameters for more 
information. 
 

Please note that in 
case of some errors the 
instrument will not trigger 
and will not record an event 
even if all triggering 
conditions are met. 
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5.14 Test Parameters 
The Test functions are used for thorough testing of an instrument. There are several groups of tests and 
every group can be selected or deselected for testing procedures. They are Analog, Hardware, Real time 
clock, Voltage and Memory tests. These five groups correspond to the five groups of errors and warnings. 
Pressing the button 
[Display Errors and 
Warnings] will take you to 
the Errors and Warnings 
page. 
 
An Instrument can perform 
tests periodically as often 
as specified by the Test 
Interval parameter. For 
some instruments the value 
of 0 means that periodical 
tests are disabled. A user 
can also force testing at any 
time. To do so, one has to 
connect to the instrument 
and press the button [Run 
Test Now]. Be patient: this 
operation can take long. 
Depending on the selected 
tests, it can last up to 2-3 
minutes and an instrument 
does not accept any 
command during this time. 
If user initiates the test, the 
results will be logged to the 
self-test results file. Its 
format is described in the 
Appendix D. Format of the 
status files. 
 
The instruments of type GSR-18 acquire the additional information during testing: natural frequency and the 
damping factor separately for every component. This information is displayed in the table Parameters of the 
Sensor. If the test was not performed yet or the information cannot be gathered due to some other reason, 
the "N/A" is indicated. 
 
With the other options you can specify whether the test pulse must be saved to the test file and whether the 
instrument has to check the sensor permanently. 
 
As soon as the test has been completed or failed, you will see the corresponding message below all controls 
of this page. 
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5.15 Parameters of the Power and Batteries  
This page indicates the current status of power and batteries. The only parameter you can enter is the dates 
of installation and replacement of the main and backup batteries.  
 
Every time, when you 
replace them, update these 
dates according to the 
actual parameters of the 
batteries so other people 
can see when the batteries 
must be replaced next 
time.  
The other information 
provided in the group 
Batteries indicates the 
actual voltages of both 
batteries as well as their 
minimum voltages at which 
the instrument is still 
expected to work. 

There is also information 
about AC power available. 
The field Powered by 
indicates whether AC 
powers the instrument.  In 
case there were power 
losses detected, one can 
see the number of Power 
losses as well as the date 
and time of the Last power 
loss. 

You can reset the counter 
of power losses at any time 
by pressing the button [Reset Power Loss Counter]. 
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5.16 Parameters of Alarms  

This page allows the settings of the instrument alarms to be made. Alarm is the signal, which is issued to the 
external connector INTERCON if a specified threshold level of the signal is exceeded. Please note that your 
instrument has to be equipped with the alarm option. There are two main alarm signals (Low and High) and 
the threshold levels can be 
set for them channel-wise.  

So if you would like the 
alarm(s) to be provided by 
the instrument, Enable 
Alarms first and then set 
the desired threshold levels 
for both high and low 
alarms. You can also set 
here the Alarm Active 
Time and instruct the 
instrument whether alarms 
are enabled during the 
self-test. 
Some instruments support 
also one more alarm signal 
(AL3), which can be 
activated on any Error, 
Warning or on AC loss or 
on every Event Trigger. 
But even if it is supported, 
this option is not available if 
GPS is connected to an 
instrument. Latest versions 
of the GSR-18 instruments 
support one more option: 
they can activate the AL3 
signal on instrument 
errors only. 

You can test alarm signals at any time by pressing the corresponding buttons [Test Low Alarm] or [Test 
High Alarm]. The current status of Low and High alarms is indicated below every button. 
Some types of GSR-18 instruments (firmware versions 02.04.xx) use low threshold value in order to declare 
events and to start recording (which is always enabled) and only the high level is used to generate an alarm. 
The "Event Trigger" page is simplified for this type of instruments and cannot be used to set thresholds for 
the event trigger. These instruments do not support alarm AL3. 
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5.17 Parameters of the Batch Mode 
The parameters of this page are available only for instruments, which support the batch mode of 
communication with SMS messages, such as GSR-18 firmware revision V 02.02.15 or higher.  
 
In order to set all the 
parameters of this page you 
have to Enable SMS 
sending first. The 
telephone number of GSM 
modem, which will receive 
SMS messages, must be 
entered in the 
corresponding field. If the 
first character is '+' then it is 
supposed that the telephone 
number is provided in the 
international format with 
country code, etc. 
 
You can also specify to 
Send a copy of every SMS 
to the secondary number 
and enter this number in the 
corresponding field as well. 
 
Further one can set whether 
the state of health (SOH) 
information is sent by SMS. 
If you enable this option, 
one has to set how often 
and at which time the 
periodical SOH report is 
sent out. 
 
The instrument can send SOH reports when the status of errors and/or warnings is changed. 
 
With the last group of controls you can instruct the instrument to provide an information about detected 
events. If Send EVT is enabled, the first message is sent out as soon as the event has triggered. This 
message can be repeated after the specified time interval if the event trigger is still active. If Send FIL is 
enabled, an SMS is also sent out on completion of the event. GeoDAS must confirm this message and if the 
confirmation does not arrive within the specified time interval, then the instrument resends this message 
again as many times as indicated. 
 
The EVT (event detected) and FIL (event completed) are not just notifications of events. They carry important 
parametric information about the event parameters, such as peak values of acceleration, velocity and 
displacement, etc. 
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5.18 Parameters of the Printer  

GSR-12/16 and GCR 
instruments support serial 
printer. You can either 
activate or de-activate 
printer output and if it is 
active, one can specify 
what kind of information 
you would like to print out 
with the corresponding 
options grouped as Printer 
Output Contents. 

 

Note that the serial printer 
and GPS receiver cannot 
be connected to the 
instrument at the same 
time. 
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5.19 LCD Display Settings 

This setup page specifies 
which information is 
displayed in the instrument 
LCD screen. Checking of the 
tickboxes enables the 
corresponding indication in 
the LCD display. 

This page looks different for 
the GCR instruments 
because they have some 
specific options to display in 
the LCD screen. 
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5.20 Annunciation 

This setup page is available for the special instrument only, GeoSIG annunciator. Main functionality of 
annunciator is to combine the Trigger and Error hardware signals coming from several recorders (up to 8) 
and to manage the alarm 
logic. Alarm signals are 
indicated with the light 
signals and can be reset by 
operators with the 
corresponding buttons. 

The GeoSIG annunciator 
(GAN) is configured as any 
other instrument through the 
Instrument Setup Manager 
but some configuration 
pages (Event Trigger, Data 
Streams, etc.) are not 
accessible because of the 
limited functionality of GAN, 
which does not work with 
seismic data. 

The table Status of Sites 
indicates annunciation 
parameters of all recorders 
connected to annunciator 
channels. Only the sites 
(stations) known to GeoDAS 
through their Work Options 
as connected to the 
annunciator, appear in this 
table. The columns Status, 
AC power and Link indicate 
correspondingly whether a 
station experiences any 
hardware error, whether the AC power is lost and whether the link to this station can be established. This 
information is provided to annunciator by GeoDAS, which checks the status of configured sites (stations) by 
logging to each of them continuously. The only adjustable parameter in this table is the Trigger flag. Click it 
with the mouse to change the state from Enabled to Disabled and vice versa. Only enabled triggers are 
counted by the trigger logic scheme, and if their number reaches the value required for common trigger an/or 
alarms, annunciator takes the corresponding actions. 

The group “Annunciator Settings” has several adjustable parameters. The number of stations required 
for common trigger indicates how many stations must trigger simultaneously in order to produce the 
common trigger signal. This signal is sent by annunciator to all configured stations forcing them to record an 
event. If the number of stations triggering simultaneously reaches or exceeds the number of stations 
required for the trigger alarm, the corresponding TRIGGER alarm signal is generated. If the option Enable 
PC watchdog is set and there was no communication between GeoDAS and the annunciator board during 
the specified communication timeout interval (in minutes), the ERROR alarm is generated. 

Annunciator can generate four alarm signals, which are indicated in the Alarms panel of the Annunciation 
setup page: TRIGGER, OBE, SSE and ERROR alarm. The ERROR alarm is set if any configured stations 
experiences an error or the PC watchdog is activated. Note that all the alarm indicators are shown inactive 
(greyed) if GeoDAS is not logged in currently into the annunciator. The TRIGGER alarm is set under the 
conditions described above. OBE and SSE alarm can only be set by GeoDAS based on the positive results of 
the OBE/SSE event checks. Please refer to the Appendix J. Event Checks for more information about this 
extended GeoDAS functionality. 

When the status of sites is changed, it is logged into the Annunciation status file. The alarms are logged as 
well. The format of status file is described in the Appendix D. Format of the status files. 

 



GeoDAS_Manual.doc/03.09.2003  GeoSIG Ltd. 
GeoDAS Software Manual  Page 6-39 

6 Recording the Events 
The most typical operation mode of GeoSIG instruments is the standalone recorder. After the installation of 
such an instrument, one has to set its parameters in a way that the instrument will be capable of recording 
the events. The event files containing data records are kept in the recorder memory, which is usually an ATA 
flash memory card or on-board SRAM. 
 
As soon as new event files are saved to the recorder memory, one can login to this recorder with GeoDAS 
and can download these files to the computer. Further the event files can be viewed, processed and analysed 
with the Off-line Data Viewer. Thus there are three steps in getting and processing the event files: 
1. Configuring the recorder and acquiring the data 
2. Downloading data files to the computer 
3. Analysing downloaded data files 

6.1 Configuring the Recorder 
In order to configure the recorder, you have to log in to it and to set its recording parameters with the 
Instrument Setup Manager. The most important settings are grouped in the page Event Trigger Parameters. 
There are following possibilities to make the recorder creating event files: 
• Level trigger. An event file is created if the level of signal exceeds the threshold value; 
• STA/LTA trigger. The ratio of short time average and long time average of the signal level must exceed 

some predefined value (which is set in dB) in order for the file is created; 
• Hardware trigger. The trigger signal is issued by an external device connected to the recorder through the 

special interface; 
• Network trigger. The trigger signal arrives from another GeoSIG recorder through the interconnection 

interface. Refer to the issue Interconnection Parameters for more information; 
• Time based trigger. The recorder creates data files according to the predefined timetable as it is 

described in the Time Triggers; 
• Manual trigger. The recorder can be forced to create an event file at any time by the command from 

GeoDAS when it is logged in to the recorder; 
• Test record. It is file similar to the even file, which is recorded during the instrument self test if the test 

pulse recording is enabled. Refer to the issue Test Parameters for more information; 
 
When the instrument is configured, you can logout and leave it alone to record event files. 

6.2 Downloading Data Files 
In general there are two possibilities: either data files are downloaded by GeoDAS automatically or the user 
can do so at any time in the manual mode with the Event File Manager. 

6.2.1 Working with the Event Manager  

This tool is launched for a selected station either from the context menu of the General Information window or 
by pressing the third button on the Station toolbar. The following dialog box appears: 
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The upper part of the window shows the list of files stored in the instrument containing most important 
information for each file. Below the list there is general file information, current status and the preview 
window. The control buttons are located at the right side. With the Event Manager one can see the instrument 
file directory, download files from a recorder, delete one particular file (ATA only) or all files.  
As you can see, the list of files displays the following information: 
• Long file name containing the station code and date/time stamp; 
• File type (Event, Test or Perm. - for permanent records of GCR instruments) 
• Date and time of the event 
• Event duration 
• Trigger flags, which show the reason of triggering this event 
• Peak values of all instrument channels 
• Status of the event file. The letter ‘D’ indicates that the file was downloaded at least once from the 

recorder. ‘L’ means that the file exists locally on the hard disk in the default data directory 
 

When pointing to a filename with the mouse cursor and the file is stored in the ATA flash card, the small 
window ("tool tip box") displays a short name of the pointed file. The file is stored in ATA card under this 
name, which you can see if you insert ATA card into the PCMCIA slot of your computer 
 

Point to the trigger flags with the mouse cursor to see their meaning with the tool tips 
 
The preview window displays graphically the data of a file, which is downloading. As soon as the downloading 
process has been completed, you can simply double-click the preview window to launch data viewer for the 
current file. 
 
The General file information indicates how many files are stored in the instruments and the amount of used 
and total memory. Two values are given for GCR instruments in the form: “Events + Permanent Records”. 
 

6.2.2 Brief description of the buttons 

[Connect /Disconnect] Forces login to the instrument or logout from it. 

[Trigger Now] Starts and stops the Software trigger. 

[Exit]  Quits the Event Manager. 

[More /No Details] Hides/shows preview window and general information. 

[Download All] Downloads all files from the instrument. May take long time. 

[Download All PR] The same operation but for the permanent records of GCR instruments. 

[Delete All/Format] Deletes all event files from the instrument. In case of ATA instruments the 
formatting of ATA Flash card is also performed. All files will be lost.  

[Delete All PR] The same operation but for the permanent records of GCR instruments. 

[Defragment] De-fragments the ATA Flash card. This can take some minutes, depending on the 
number of files. 

[Continuous Trigger] This button is currently available for the GT-316 instruments only. When it is in the 
pushed state and you are logged in to an instrument, GeoDAS will force the manual 
trigger every time when the previous event is completed. As soon as the instrument 
memory is filled up with the data, GeoDAS downloads all recorded files and deletes 
them from this instrument. Then new series of manually triggered event files is 
recorded, etc. Please note that the process of downloading cannot be cancelled by 
releasing the button.   
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6.2.3 Context Menu of the Event Manager  

Context menu becomes active if one or more files are selected from the list 
 
 Download   

Downloads selected file(s) to the PCs hard disk 
 

 Delete   
Deletes selected file(s) from the instrument memory (ATA card 
only) 

 File Information   
Displays information about selected file(s) 
 

 View Data   
Launches data viewer for the selected file(s). If some selected files are not yet downloaded, their 
waveforms will not be displayed 

6.2.4 Downloading data files with Event Manager 

To download data files from an Instrument with Event Manager please follow these steps: 
1) Click [Connect] button to login to the instrument; 
2) If there are files in the instrument memory, they will be displayed in the list as soon as you get 

connected. If you would like to select some particular files, sort list of event files first. For instance, if 
you would like to see the strongest events, sort the list by peaks; 

3) Select desired files to download and run "Download" from the context menu; 
4) Or just skip 2 and 3 and click the [Download All] button to download all events; 
5) Make sure all files / selected files are downloaded; 
6) Select files, which are not needed and delete them (item "Delete" of the context menu, which is valid 

for ATA-flash cards only) or delete all files by pressing the button [Delete All/Format]; 
7) If you have deleted several particular files but not all of them, perform memory de-fragmentation 

(ATA-flash cards only). This operation can take long and therefore we recommend avoiding it. The 
best approach is to download all files to the computer and then simply format the ATA card. The 
instrument performs quick format, which usually takes not more than several seconds; 

8) Click [Disconnect] button to logout from the instrument. 
 

6.3 Automatic file downloading 
The data acquisition system can be configured for the automatic data downloading. While configuring a 
station, enable the option “Autodownload any new file…” in the Work Options, which ensures that all data 
files are downloaded automatically upon every login to the instrument. So if you have a direct communication 
channel to the instrument (cable), you can leave it on-line and GeoDAS will download every new file to the 
computer. It is recommended to enable also the “Autodelete…” option in order to avoid the situation when the 
event memory gets full. Otherwise you have to check the status of the instrument periodically and delete all 
unnecessary files manually. 
 
If your instrument is accessible through the dial-up communication channel, you cannot leave it on-line all the 
time. But in such a case the instrument can inform GeoDAS when the new event is recorded. Setting the 
instrument option “Enable AutoDial on event” activates this functionality, see the issue Communication 
Parameters. The telephone number and the dial command must be specified in the “Auto Dial String”.  
 
Thus in order to configure an automatic file downloading, do the following: 
Enable the option “Autodownload any new file…” in the Work Options of the stations 
Enable the option “Autodelete…” in the Work Options of the stations (recommended but not required) 
If you have a permanent connection to the instrument, do the following: 
• Select the mode Check up the status of this instrument permanently in the Work Options. 
You can also keep GeoDAS logged in to the instrument permanently: 
• Set Idle Timeout to disconnect from a PC (Communication Parameters) to 255 
• Login to the instrument and leave it on-line 
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If you have a dial-up connection to the instrument, do the following: 
• Activate the option “Enable AutoDial on event” (Communication Parameters)  
• Enter the dial command and the telephone number of your local modem in the field “AutoDial String”, for 

instance ATDP3178920 
• Set the option “Modem receives the incoming calls…” in the Other communication parameters for the 

current station. 
 
If it is not required downloading the files immediately after an event, you can do so periodically instead. 

The above actions 3 and 4 are not necessary in this case but you have to select “Login to the instrument…” 
in the Work Options and to specify the corresponding time interval. 
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7 The Main Menu 

7.1 File Menu  
Most of the items in this menu are related to the functions of ODV. These items are available only when at 
least one ODV window is opened. Please refer to the chapter Off-line Data Viewer for the detailed 
information. 
 
 Open    

As all data sets are loaded from the instrument 
and are saved to the hard disk as data files, those 
files can be opened to view their data with the 
standard Windows File/Open routine. A Data 
directory and a file to open are selected with the 
standard Windows browser. 

 Since GeoDAS registers the known event 
file types (extensions) to the Windows 
environment, the event files can also be open 
directly from Windows Explorer simply by double-
clicking them. If GeoDAS is not yet launched, it is 
started automatically. You can also drag the event 
files from the Explorer window or from the desktop 
and drop them to the GeoDAS window to open 
these files. 

 
 Add Data    

Allows a data file be selected with the Windows 
browser and be added to the current data view. 

 
 Export Text    

Exports currently viewed data into the ASCII file. 
The current type of the time and data scales of the graph affects the format of output file. In particular, it 
specifies whether the data are saved in the physical units or in counts, whether the column of time is 
saved, etc. 

 The export function works only if at least one graph is selected (highlighted). Only selected graphs 
are exported. The target ASCII file has the same name (but the TXT extension) and is located in the same 
directory as the source file. 
 

 Save Event    

Creates an *.evt file (a name and the output directory can be selected with the standard File Save dialog), 
which contains the information about all graph data sets currently displayed in the active graph window. 
The corresponding data files can be in different directories and it is not required that they are time 
synchronised. This feature is useful to combine several independent data files recorded by different 
instruments into one event record. 
 

 Find Event    

This menu item launches a routine, which performs the search for the data files recorded in the same time 
interval as the currently displayed data file. You have to select a directory where the search will be 
performed. 

 
 Capture Window    

Saves currently active graph window (viewed area only) into a file using one of the following formats: BMP, 
PNG or JPG. 
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 Capture All    
Saves currently active graph window (including currently invisible area) into a file using one of the 
following formats: BMP, PNG or JPG. 

  
 Print    

Prints the contents of an active ODV window 
 
 Print Preview    

Displays the simulated printout of the currently active ODV window. The features of printout are shown as 
specified with the Print Setup dialog and they can be adjusted in the preview mode. 
 

 Print Setup    

Launches the Print Setup dialog, which is used to tune GeoDAS printouts: 
 

 
 
The group of parameters “Graph Layout” specifies how the graphs are placed to the printed page and 
their aspect (width/height) ratio, which can be one of the following: 
• Default fixed. The height of every graph is equal 2/3 of its width. In this case one cannot set the exact 

number of rows since it is limited by the page height; 
• Fit graphs to page. Every graph is fitted into the area Page width / Columns by Page height / Rows; 
• Print as displayed. The height of every graph is calculated based on the width and height of the 

currently displayed graph. 
 The graphs displayed in the screen in maximised state are printed also maximised, i.e. one graph 

per page irrespective of the layout settings. In order to maximise the graph view, one should open more 
than one graph in a window and click the Maximise button located at the left side of the graph. 
 
The groups “Header” and “Footer” set the content of the page header and footer correspondingly. If the 
Frame option is enabled, the surrounding rectangle (frame) is drawn. Printout title is placed in the upper 
left corner of the print area. It can have more than one line. In this case a smaller font size is selected 
automatically. You can also select a Logo file in the BMP of JPEG format. The logo image is printed in the 
upper right corner of the print page area. If the Logo option is enabled but no valid image file is selected 
then the default GeoSIG logo will be printed. 

 The best logo output is achieved when the logo image is not scaled therefore try to select the 
corresponding image taking into account the resolution of your printer. 
 
Miscellaneous print settings include the Line width, whether the graphs are surrounded by the Frame 
rectangle and the colour options. You can either print the graphs as displayed, i.e. to keep the current 
screen colours or to always convert them to black and while. The third option combines these two 
options in a way that the conversion is performed for the black and while printers only. The user-defined 
graph templates may have customised printout settings. You can adjust them with this dialog window by 
enabling the option Print settings of the template and by choosing the name of the required template in 
the combo box. More information about graph templates is provided in the section Templates. 
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If the graphs are printed or can be printed coloured, you can also specify the colour of the text and 
frames used for headers and footers. Note that the colour options do not affect the logo image. It is 
always printed as it is set in the image file. 
 
Besides of the [OK] and [Cancel] buttons, which perform the standard operations, there are two more 
control buttons in the Print Setup dialog. The [Save] button is used to store parameters as default ones. 
This means that they will be valid on the next start-up of GeoDAS, otherwise – only during the current 
session. The button [Page Setup…] takes you to the standard Page Setup and Printer Setup dialogs, 
which are used to customise, for instance, the print margins. Note that in the Print Preview mode the 
button [OK] is replaced with [Apply], which is used to see the updated print features immediately in the 
preview window. 

  
 Close    

Closes the active ODV window. 
  
 Close All    

Closes all windows 
  
 Select Event Files    

This item is not related directly to the ODV functionality. It opens a window, which can be used to select 
some particular data files recorded by the currently configured stations: 

 

 
 
If you have an experience working with GeoSIG CloseView data analysis program, you will probably find 
this tool similar to the CloseView file selection procedure. First of all, select the station(s) of your interest in 
the left part of the window and the list of files recorded by selected station(s) will appear in the right part 
along with brief information on each file, namely: 
• Long file name consisting of the 3-character station code and the date/time stamp; 
• File type: standard GSR event file, test evebt GST, compressed event file GBR, etc.; 
• Station name where the event file belongs to; 
• Date and time of the record; 
• Number of data channels (components) stored in the file; 
• Duration of the record in seconds; 
• Peak value of all data components. Note that these value are only estimated ones and cannot be 

provided with the high precision. The exact peak values are indicated in the ODV window after 
opening a file. 

Left part of the window is a list of stations in the selected root data directory. The Files column indicates 
how many data files are available for each station. The third column in the left part of window displays the 
type of available files. If more than one type of files found in the corresponding station data directory, it is 
indicated as FirstTypeFound + N other types, for instance GSR+1. 
 
Now you can select one or more files from this list and perform the following actions listed in the context 
menu: 
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• View Data - displays file(s) data in the new ODV window. Double-clicking the name of a file performs 
the same action 

• File Information - displays general information, which is kept in the file header; 
• Delete - removes selected file(s) from the hard disk; 
 
Next items are always available, even if no single file selected in the list: 
• Update Information - re-reads data directories and updates the file list; 
• Select Event Root - allows directory other than "Data" at 

the current GeoDAS home directory be selected as a root 
data directory; 

• Find Event - searches for the data files recorded within a 
specified time interval. The start and end time (or time 
interval) are set with the dialog box “Set time interval”. 

• Export - exports the list of event files along with the 
information indicated for every event to the comma-delimited 
(CSV) file on your choice. 

 
 Event File Information   

Displays the general information stored in the header of a selected data file. The information dialog may 
show different parameters, depending on the type of instrument, which has recorded the file. 
 

 Convert     

Opens the submenu, from which you can choose a type of conversion. GeoDAS event files can be 
converted to the PC-SUDS, SEISAN waveform or to the ASCII text format described in Appendix B. ASCII 
file format used by GeoDAS. The input file is selected with the standard Windows File Open dialog. The 
target file has the same name but different extension (depending on the selected conversion) and it is 
placed to the same directory as the source file. 
 

 Exit     

Quits the program 
 

7.2 Edit Menu  
All items in this menu are intended to manipulate the data graphs 
with the ODV and therefore they are described further in the 
chapter Off-line Data Viewer.  
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7.3 View Menu 
Most of the items in this menu are related to the Off-line Data Viewer 
functionality and therefore they are described in the corresponding 
chapter, except the following items:  
 
 View Toolbar      

Shows/hides the ODV toolbar  
 
 Station Map     

Shows or hides the stations map, i.e. the window indicating the 
location of the stations with their names and with the key 
parameters on a schematic map. The simplest background for 
such picture can be just a co-ordinate grid. If a bitmap of the 
corresponding area is provided, it can be used as the map 
background. Please refer to the Appendix K. Station Map, which 
describes the way of providing information for the station maps. 

 
 Station Toolbar     

Shows/hides the Station toolbar  
 

7.4 Analyse Menu  

 This menu contains the list of available mathematical operations, which can be performed with the graphs 
(data sets)  shown in the current ODV window. They are described further in details in the chapter Data 
Analysis. 
 

Please note that the analysis functions work in the registered GeoDAS versions only, which have the 
correct nonzero registration number. 

 

7.5 Settings Menu  

Various parameters of GeoDAS can be set with the items of this menu. 
Most of them allow the extended functionality of GeoDAS to be adjusted 
and therefore they are not used so often. Please refer to the 
corresponding articles in the chapter The Other Capabilities of GeoDAS 
for the detailed explanation. 

 

 Configure Stations     
This item is used frequently. It helps you to make a first step after 
the GeoDAS installation - Configuring the Stations you are going to 
work with. Follow the link above for the step-by-step description of 
this procedure. 

 
 Remote Links       

GeoDAS can communicate to the other GeoSIG applications (other instances of GeoDAS, Rapid 
Response mapping application) for the purpose of their monitoring, to exchange setup parameters, 
etc. Other applications can be installed in the same or in the different computer but in any case the 
TCP/IP protocol is used for this communication. GeoDAS can provide also its data streams for the 
further processing to an external seismic software package, for instance, to USGS Earthworm 
http://www.cnss.org/EWAB/toc.html. Prior to use these extended network features you have to 
configure the network links of GeoDAS as described in Appendix G. Network Links of GeoDAS. 

 

 

http://www.cnss.org/EWAB/toc.html


GeoDAS_Manual.doc/03.09.2003  GeoSIG Ltd. 
GeoDAS Software Manual  Page 7-48 

 Network Monitor      
This feature is only available in the Monitor Mode of GeoDAS. Please refer to the Appendix I. Monitor 
Mode of Operation for the further detailed description of this mode. 

 
 Strong Motion Data     

Allows the parameters of the strong motion data acquisition to be adjusted. Input data, such as peak 
ground acceleration, peak ground velocity, spectral accelerations or displacements at different 
frequencies can be provided by a network of GeoSIG GSR-18 seismic recorders. GeoDAS acquires all 
these data and forwards it for further processing to an external application. Currently the only 
processing program, which is supported, is the GeoSIG Rapid Response mapping application. One 
can find more detailed description in the Appendix E. Strong Motion Data Processing. 

 
 Data Streams       

If your instrument(s) can provide data streams and this mode is enabled, one can activate the Data 
stream Manager with this item and set various options of data processing. You can configure local 
level triggers for every data stream and specify whether the event files must be created on every local 
trigger. You can configure the network trigger according to some simple criteria and specify whether 
this trigger must activate an alarm system. All data arriving with the stream can be stored as binary 
files and displayed afterwards with the Off-line Data Viewer. Finally you can forward streams of data for 
processing by the external application. All these options are described further in the chapter 
Processing Stream Data. 

 
 Messenger       

GeoDAS can send notification messages about its status or/and about the status of the configured 
stations, periodical state-of-health (SOH) reports, etc. This information is delivered to recipients by e-
mails or/and by SMS messages to mobile phones. In order to activate these features, you have to 
perform the Messenger setup as it is described in the Appendix F. Messenger of GeoDAS. 
 

 Statistics       
GeoDAS can acquire some statistical information while communicating to the configured stations. This 
information can be used to optimise communication parameters for the purpose of debugging. 
Statistics setup allows this feature to be activated. 
 

 Event Checks       
Launches the configuration dialog to set up the Event Check Parameters. 

 
 Configure ADC Channels    

Launches the dialog window used to set up the Configuration of ADC channels. 
 

 Miscellaneous      
Few parameters, which do not 
belong to any group of settings 
listed above, are adjusted 
through the Miscellaneous 
Parameters dialog. 
 
Some applications require that 
several configured instruments 
perform their self-tests by 
coordinated manner at strictly 
defined time. GeoDAS can be 
instructed to take care of this 
action by enabling the option 
Test all instruments 
periodically. If this option is set, GeoDAS will log into every instrument at the specified time and will 
force its self-test. The instruments are tested one by one with a delay of several minutes to ensure that 
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only one configured instrument is out of normal operation during the test procedure. Note that the test 
is performed according to the currently enabled test options. Therefore please make sure that the 
required tests are enabled in the page Test Parameters of Instrument Setup Manager. The results of 
self-tests are logged to the self-test status file described in the Appendix D. Format of the status files. 
 

Since the instruments can perform the self-test automatically, GeoDAS tries to disable this feature 
by setting the test interval parameter to zero at first login. But this function works only for the latest 
versions of GSR-18 therefore the feature Periodical Tests can be used effectively only with this type of 
instruments. 
 
The option Ask for a password at startup can 
be used in some rare cases to protect GeoDAS 
and the current working parameters from 
accessing by unauthorised persons. Note that if 
you change this option, you will be asked for a 
password too.  

 
 

7.6 Tools Menu 
GeoDAS tools are the modules providing some additional functionality, 
which is not related directly to the general tasks of GeoDAS application. 
These modules can be external programs.  
 
 
 
 

 Terminal    

This menu item launches the GeoDAS 
Communication terminal. This tool is 
used to communicate through a serial 
port in manual mode. It is launched 
from the main menu Tool->Terminal. 
Select the serial port from the list of 
available ports and the desired baud 
rate then press the button 
[Connect/Disconnect] to open the 
port. Now you can enter the 
commands in the upper part of 
window and see the response in the 
lower part. 
 
The receiving data can be displayed 
not only in ASCII but also in hex format, depending on the option Hexadecimal display. 
Note that this dialog box is resizable, so you can make both receiving and sending fields bigger. 
 
When you have finished working with Terminal, press [Close] to disconnect and exit from the terminal 
window. 

 

 Editor of Limit Files     

This tool is used to create and to edit limit files, which keep the design limits of RSA and RSV used for 
checking events for the OBE and SSE criteria. More information is provided in the section Editor of 
Limit Files. 
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7.7 Window Menu 

This menu provides a user with the standard Windows operations applicable to the GeoDAS child 
windows: 

 Cascade      

Arranges GeoDAS windows in the 'Cascade' 
fashion 

 Tile      

Arranges GeoDAS windows in the 'Tile' fashion 

 Arrange Icons      

Arranges minimised GeoDAS windows (icons) 

 Save Configuration     

Stores the sizes and positions of all GeoDAS 
windows, which are currently displayed 

 Load Configuration     

Arranges all GeoDAS windows in the screen, as they were located during the previous saving of 
their configuration. 
 

The second part of this menu lists all the opened child windows. The title of one, which is currently active, is 
shown as checked. 
 

7.8  Help Menu 

 Help Topics  

Launches the help system and displays contents of the GeoDAS on-line help. 

 Registration  

Registration information displays the user name and company 
name entered during the GeoDAS installation, and a 
registration code (serial number). If you did not order an 
Analysis option, you can do so at any time. You will receive 
then a valid serial number of your product, which must be 
entered with the Registration dialog in order to make the 
Analysis menu accessible. 

 About GeoDAS  

Brief information about the GeoDAS application. 
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8 GeoDAS Main Information Windows 

8.1 GeoDAS Logger  

The window called “GeoDAS 
Logger” displays system messages 
with the information about current 
status of the system and about the 
important events that are 
happening during operation. 
Messages always have a prefix 
that is the current time. Most of the 
error and warning messages have 
also prefixes ERR> and WRN> 
correspondingly. The types of 
messages can be distinguished by 
colour too: errors are indicated with 
red colour; warnings are marked with yellow colour; other messages are just black text. 

In the log window “GeoDAS Logger” you can see only last messages. After a certain amount of messages 
the oldest one is deleted from the log window. But in any case all the messages are kept in files named as 
“LogFile_GeoDAS_TIMESTAMP”, one file per day. Time stamp has the format YYYYMMDD so, for example, 
the log file of January 15, 2000 is called “LogFile_GeoDAS_20000115”. The Log files are kept in the 
"LogFiles" subdirectory of the home GeoDAS directory.  
 

You can enable more messages in the logfile for debugging purposes. In order to log additional 
information, GeoDAS is started with the debug option –d[c][h][s], where c is used to log various 
communication related messages, h – to report hardware problems, commands sent to the instrument, etc. 
and s is used to log additional data stream related messages. For instance, GeoDAS –dh will force logging of 
the extended hardware-related information. 

8.1.1 Context Menu of the GeoDAS Logger 

Context menu of the Logger window is shown in the picture above. It contains of the following items: 
 
 Open this Logfile   

Opens Logfile of the current day with the default Windows editor (Notepad) for the detailed view 
and analysis of all messages. Please note that this file is already open by GeoDAS for writing and 
therefore you cannot save any changes you probably made to this file. 

 Open Logfile...    

Launches the standard File Open dialog in the LogFiles directory so you can select a file you would 
like to open. 

 Autoscroll Log    

This switch specifies whether the content of the Logger window must be scrolled automatically 
when a new message is added to the log. This option is turned ON by default. 

 Network Messages    

The dialog launched by clicking this item lets you configuring the remote links of Logger. Those 
applications selected to communicate can exchange (send and/or receive) some important log 
messages. 

 



GeoDAS_Manual.doc/03.09.2003  GeoSIG Ltd. 
GeoDAS Software Manual  Page 8-2 

8.2 Stations: General Information 
This window contains the table filled up with the general information for every configured GeoSIG seismic 
station. General Information window is opened if at least one station is configured. It can be minimised or 
restored but never closed. 

 

8.2.1 Description of the information 

The following information is displayed in this window 
  
Station Unique station name, which is entered while adding a station. This name is used by GeoDAS 

only and is not stored in the instrument memory. A coloured dot displayed on the left reflects 
the status of errors and warnings updated during last connection to an instrument or 
provided with the latest SOH report. The red colour indicates errors, orange colour indicates 
warnings. A green dot means normal operation. Refer to the Errors and Warnings 
information page (below) for more information. 
 

Code Station code. Three-character station identifier stored in the instrument. Can be changed by 
the Setup Manager (see page Station). 
 

Instrument Type of the instrument: GSR-12,16,18,24, GBV-116, 316, GCR-12,16, etc. 
 

Channel 
Type 

The type of communication channel, which is used to access the instrument. Can be either 
Direct Link or Modem (dedicated, at some COM port) or Shared Modem. In case of dial-up 
link (modem), the telephone number of the station is also indicated in the list. Refer to the 
Communication Channel Setup for more information about communication channels and 
their configuration. 
 

Updated Date and time of the last update (last SOH report or last connection to an instrument). 
 

Files Number of event files recorded (i.e. stored in the instrument) and number of files 
downloaded to the hard disk by GeoDAS (shown in brackets). 
 

Free 
Memory 
 

Free instrument memory in Kbyte. If an instrument works as digitizer only and does not have 
event memory available, "No Memory" is indicated. 

Last Event Date and time of the last recorded event or "Not Supported" if the instrument cannot record 
event files. 
 

Voltage Actual DC power voltage on the last login and the indication whether the instrument is 
powered with AC. 
 

Current 
Activity 

Current status of the link to instrument when logged in, otherwise "Not Connected"  

 
The information listed above is updated upon every login to the instruments. Some information (status of 
errors and warnings, number of recorded files, amount of free memory, etc.) can be updated without logging 
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into an instrument, for instance, from the data stream or when GeoDAS receives a SOH SMS message. But 
not all types of GeoSIG instruments support these options.  
 
You can sort the information in this window. 
 

In order to sort a list of items in some window, click on the header of a column, which you would like to 
use as a sorting criterion. Next click to the same header will change the order of sorting 
(ascending/descending). This is a general rule for all information windows of GeoDAS. 
 
The information displayed in this window is saved to a file when GeoDAS quits and is loaded to the window 
upon the next startup. 

8.2.2 Context Menu of the General Information Window 

Context menu of the General Information window provides an access to the important operations with the 
stations. First group of items in this menu is available only if some station in the list has a focus, i.e. its name 
is surrounded by the dotted rectangle. Only one station can have such a focus at any particular time and the 
listed below operations are applied to this station: 
 
 Event Manager   

Launches a tool, which helps a user to manage event files stored in the instrument. When logged 
in, one can see the list of recorded event files with their main parameters, one can download file(s) 
and/or just delete them from the instrument memory and perform some other operations. Follow the 
link Working with the Event Manager to get familiar with this tool. 

 More Information    

Provides detailed information about the station. All instrument parameters are grouped in to the 
pages according to their purpose and it is done exactly in the same way as with the Instrument 
Setup Manager. The only difference from it is that the pages do not contain any control buttons and 
the user can only monitor all parameters but cannot change them. 

 Instrument Setup   

Almost all GeoSIG instruments can work in the standalone mode, i.e. without being connected to a 
computer permanently. They work according to the set of various parameters and the Instrument 
Setup Manager can set any of those. This is the biggest and one of the most important tasks 
GeoDAS can do. Detailed information is provided further in the chapter Configuring the Instrument. 

 
Please note that the name of "focused" station appears also in the combo box of the Station toolbar. Pressing 

the 3rd and 2nd buttons of this toolbar launches the Event Manager and the Instrument Setup Manager 
correspondingly. 
 
The following operations are applied to one or more stations selected (highlighted) in the list: 

 Batch Multi-Setup   

The Batch Multi-Setup is a specific operation mode of the Setup Manager. It utilises the fully 
asynchronous, so-called "batch mode" of communication to the instruments, when several 
commands are send in the same packet without waiting for a confirmation of every command. So 
the packet can be sent out not only through the full-duplex communication channel but also through 
the half-duplex channel. The instruments capable of handling GSM modems receive such packets 
as binary SMS messages. Not all GeoDAS instruments support currently this mode because it is 
useful only in case there are many stations configured in GeoDAS and one has to change quickly 
some particular parameter(s) in all of them.  

 Clean Batch Queue   

When a batch is sent out but not yet confirmed by the instrument, the Current Activity column in the 
General Information window indicates "Pending Batches: N", where N is the number of not 
confirmed batches. If a batch is not confirmed within some time interval, GeoDAS may re-send the 
request. In order to cancel this operation and to clean up the batch queue, simply run this item for 
the selected stations. 
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 Clean SMS Queue   

If GeoDAS is configured to support communication with configured stations by means SMS 
messages, all outgoing SMS are placed to the queue for sending. If you would like to cancel 
sending SMS to a particular station, use this command to clean up the queue. 

 
The following items of the context menu are always available: 
 
 Configure Stations     

This item has the same functionality as Settings/Configure Stations of the main GeoDAS menu. 
More detailed information is provided in the chapter Configuring the Stations. 

 Export Configuration    

You may select one or several stations from the list and choose this item to save the configuration 
of the selected stations to a file on your choice. 

 Update Coordinates     
This command is used to create or update the All_stations.lst file used to plot configured stations in 
the station map. More information can be found in the Appendix K. Station Map. If no stations 
selected from the list, then all coordinates will be updated. Otherwise GeoDAS updates only the 
latitude and longitude of the selected stations. Make sure that locations provided by instruments are 
correct before running this command. 

 Network Links      

With the dialog launched upon clicking this item, you can instruct GeoDAS to exchange general 
station information with the other instance(s) of GeoDAS running in the other computers. This 
information is sent usually to the GeoDAS working in the Monitor mode. Please see the Appendix 
G. Network Links of GeoDAS for the description of the "Network Links" dialog. 

 Status Info      

The following dialog box appears when clicking this item. You can specify here whether the station 
information is sent periodically to the recipients. Two ways of the information delivery are available: 
SMS and e-mails. In the last 
case the list of instrument 
errors (if any) can be 
attached to the every email. 
Minimum interval for 
delivery of this information 
is one day. The time of 
sending is set as well. If you 
would like to deliver not only 
the general station 
information but also the 
status of data streams and 
the status of 
communication channels, 
the corresponding options 
have to be checked. 
Recipients must be listed in 
the separate files for the email and for the SMS reports. The format of both types of the files is 
described in the Appendix F. Messenger of GeoDAS.  

If you would like to attach the list of instrument errors, select the corresponding option. The format 
of the instrument error file is described in the Appendix D. Format of the status files. 

You can also maintain the extended station information in a directory on your choice. If this 
option is checked, then every SOH report from every station will be logged into a text status file 
located under this root directory for extended information. 
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8.3 Serial Communication Channels 
This window displays the 
table filled up with the 
information about all the 
communication channels 
(COM ports) used to 
access the configured 
stations. This window is 
opened if at least one station is configured. It can be minimised or restored but never closed, so it is always in 
the screen. 

8.3.1 Description of the information 

The information displayed in this window is described in the table below. You can find also some explanation 
about the types of communication channels and their parameters in the chapter Communication Channel 
Setup. 
 
Port Communication port, which provides a physical channel to an instrument. The bitmap displayed to 

the left indicates the type of a channel. COM2 in the picture above is configured for the 
permanent direct access to the instruments. Other two ports are used for the dial-up links: the 
analog modem is attached to the COM3 and the GSM modem is attached to COM1. Red 
background indicates that a link through the COM1 cannot be currently established because of a 
communication error. 
 

Baud Current Baud Rate of the serial channel. 
 

Owner The name of a station, which this channel belongs to. It can be also a name of a modem pool in 
case the channel is configured as a member of a modem pool and is not locked by any station at 
the moment. Station name is always given in the form <NAME>. It is possible in some cases that 
several stations at the same time use the same port, for instance, while receiving data streams by 
requests. Refer to the chapter Working with Data Streams for more information about this mode. 
In such cases the number of other stations that use the same port follows the owner’s name: 
<NAME>+N.  
 

Calls 
In/Out 

Statistical information indicating the number of received and made calls. This is applicable to the 
dial-up channels only, otherwise "NA" (not applicable) is indicated. 
 

SMS 
In/Out 

Number of received and sent SMS. This information can be indicated for the channels, which 
utilize the GSM modems. 
 

Logins Number of successful logins to the instrument(s) made through the current port.  
  

Errors Number of communication errors detected by GeoDAS.  
  

Status Current status of the serial channel to an instrument 
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9 Working with Data Streams 

9.1 General Notes 

Several types of GeoSIG instruments, such as GBV and GSR-18/24, can provide the streams of data through 
the serial communication channel. In most cases the same communication channel is used both for login to 
the instrument and for sending the data stream. Therefore it is important to realise that the data stream is 
always interrupted when you log in to the instrument. The data streams carry either data samples, which are 
sent in the binary format as soon as they are gathered from the A/D converters, or data packets of samples 
collected within a time frame of maximum one-second interval. In general the instruments are capable of 
recording files and sending data streams at the same time. But very often it is not required, so the 
instruments may have no event memory. They work as digitizers only providing data streams. 

If you intend to work with the data streams and the instrument you purchased provides this functionality, 
follow these steps: 
1. Enable the data stream support from the GeoDAS side while configuring a station as it is described in the 

Data stream options of Work Options issue of this manual 
2. Enable sending data streams by the instrument with the Setup Manager. Refer to the description of Data 

Streams Parameters of the Setup manager for more details 
3. Configure GeoDAS for processing the data streams. This action will be described further in more details. 
 

9.2 Data Streams information window 
If you have enabled the support of data streams for at least one configured station, the following window 
appears in the screen after restart: 
 

 

9.2.1 Description of the information 

The following information related to the data streams is indicated: 
Station The unique station name, which is entered while adding a station. This name is used by 

GeoDAS only and is not stored in the instrument memory. A bitmap displayed on the left 
reflects the quality of data stream. Red colour indicates fatal errors (no data at all), orange 
colour indicates warnings (single lost packets). Green bitmap means normal operation. 
Red cross indicates that data stream from the corresponding station is interrupted 
because the user is currently logged in to the station or the communication port is used for 
an ASCII terminal.  
 

Code Station code. Three-byte station identifier stored in the instrument  
 

Data Stream Data stream parameters (components, LSB, sampling rate) 
 

Instrument 
time 

Time stamp as it is indicated in every data packet arriving from the instrument 
 

GPS status Status of GPS receiver if it is connected to an instrument, locked and receives 1PPS 
signal, the “Locked” is indicated, otherwise “Not Sync”. If there is no GPS connected, the 
indication is “No Info”. 
 

Lost Data Quality of the link to instrument (percentage of data packets lost during last minute, hour, 
day) 
 

Trigger Status of the event trigger. Available indications:  
OFF – the trigger is not activated for the current station; 
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INI – the initialisation is performing; 
RDY – initialised and is ready to trigger; 
REC – recording an event. 

DC offset Signal DC offset displayed either in counts or in physical units 
 

Amplitude Average amplitude of the signal (counts or physical units) 
 

 

9.2.2 Context Menu of the Data Streams Window  

As one can see from the above picture, there is a context menu available in the list of data streams.  

 Data Monitor      

One can select several data streams from the list and then launch the Data Graph Monitor (see below) 
to display those streams.  

 Physical Units      

This menu item specifies whether DC offset and Amplitude must be displayed in physical units or just 
in counts. 

 Start/Stop Recording     

Running this menu item forces GeoDAS to create event file(s) and to save stream data. Prior to use 
this feature you have to run the Datastream Manager Setup (Settings->Data Streams) and to enable 
creating event files from data streams on any local trigger or on a network trigger. Please also 
make sure that the column Channels of the table of local triggers does not indicate "None" for the 
stations, which will record data. Otherwise data channels are not initialised and therefore the manual 
trigger will not be started. Note that the manual recording is terminated automatically upon elapsing of 
the time interval indicated as Max. duration. Refer to the section Processing Stream Data for more 
information about Datastream Manager Setup. 

9.3 Data Graph Monitor  
The Data Graph Monitor is a graphical representation of the active data streams. The data signals arriving 
from the instrument are displayed as waveforms. They are updated upon receiving of every new packet. 

9.3.1 General Information 

All data channels are displayed separately. Every signal trace has its own view and they cannot be 
overlapped. The name of the station and the component name are indicated in the right lower corner of a 
view for every channel. Start time is indicated in the left upper corner of a channel view. Zero level and the 
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scale limits are shown as well. The synchronisation status of the signal is indicated with the trace colour: If 
the waveform is plotted in yellow colour, the station’s GPS has synchronisation. 
 
Main parameters of the Data Graph Monitor are adjustable with the context menu, which is described below. 

9.3.2 Context Menu of the Data Graph Monitor 

The menu has following items: 
 
 Add/remove channels      

Launches the dialog to add new channels to the monitor window or to remove the existing one(s). 
New channels can be selected from the set of all existing data streams of the configured stations. If 
one or more channels are 
selected in the list, use the 
buttons [ Add] and 
[Remove ] to perform the 
corresponding actions. 

 
Please note that the 

view of every channel trace 
has some minimum 
dimensions and therefore only the limited amount of data channels can be added to the window. In 
order to see more channels in the window, you have to increase its vertical size first and then add the 
channels. 
 

 Countdown Time    
Lets you adjusting the length of a time frame of all displayed signals with the following dialog: 
 

 
 Redraw Monitor    

Updates the monitor window 
 

 Physical Units    
Switches between counts and physical units displayed in the Y-axis. 

 
 Synchronised Display    

This option, if selected, makes all displayed channels synchronised in time, irrespective to the time 
when the data packets were received. Otherwise all waveforms are updated as soon as every next 
packet is received and the currently displaying fragment of every waveform has its own start time 
indicated in the upper left corner of every graph channel. 

 
Items of the next group of the context menu are applicable to a channel trace, which is pointed currently, i.e. 
located under the upper left corner of the context menu.  
 
 Auto Scale Channel    

Specifies whether the scale of the current channel must be adjusted automatically. Otherwise the 
fixed scale specified by a user is taken. 
 

 Compensate for Offset   
Specifies whether the signal of current channel is displayed with or without offset removed. 

 
 Keep Current Scale     

Causes the current scale limits to be saved and used when the Auto Scale option is turned off. 
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 Set Channel Scale    
Launches the dialog allowing a fixed Y-scale to be set by user. 
Auto Scale must be off for this option to work. If the channel 
scale is displayed currently in physical units then the limits must 
be entered in these units, otherwise in counts. 

 
 Remove This Channel    

Removes a channel under the upper left corner of the context menu. 
 

 Send Testpulse    
This option works only for the instruments, which send data packets by request. The instrument is 
forced with this command to send a test pulse, which can be seen in the screen as a “step” in the 
signal. 

 
 Launch at Startup    

The last option of the context menu, if enabled, instructs GeoDAS to launch the Data Graph Monitor 
automatically when the program starts. 
 

9.4 Processing Stream Data 

Processing of data streams is disabled by default. Run Settings->Data Streams item from the main menu in 
order to configure the data stream processing. The following dialog appears: 
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The first group of controls specifies the data storage options. You would probably like to keep all active 
streams of data in local data files. In this case the maximum length of data chunk must be set as a time 
interval in minutes. If some data blocks of the stream are lost within this time interval, GeoDAS may create 
more than one file to keep the data. But each data channel creates in general only one file. For instance, if a 
station provides three components of the signal in a data stream then three files will be created. 

Since the data files are recorded permanently, the hard disk of the computer is filled up with data quickly. 
Therefore care must be taken to avoid hard disk overflow. You have to set the minimum amount of a hard 
disk free space, which is allowed for the normal operation of GeoDAS and the Windows operating system. If 
the free space reaches this limit, GeoDAS will delete the oldest data stream files in order to continue 
performing normally. Additionally, the lifetime of data stream files can be set with the option Remove data 
files older than the time interval specified in hours. Data stream files can be viewed and processed in the 
same style as the event files with the Off-line Data Viewer. 

Besides of keeping data streams locally GeoDAS can forward the data to a remote computer(s) for further 
processing. For instance, in order to forward the data to the USGS Earthworm software, you have to: 
• enable the corresponding option Broadcast raw data to... in this dialog 
• enable broadcasting of datagrams while configuring the network links of GeoDAS, the button [LAN 

Configuration]  
• install and configure the utility geodas2ew in the computer(s) running Earthworm 
 
The group of controls called Network Trigger combines the settings of triggering conditions. You can 
enable/disable the network trigger, specify the time aperture of the seismic stations network and set the 
minimum number of stations, which must issue the local trigger within the time aperture in order to declare 
the network trigger.  There is the option of selecting the moving average filter. If it is checked, a number of 
points to average must be specified. You can also choose the triggering algorithm, which can be one of 
the followings: absolute level exceeding, STA/LTA based or CAV (Cumulative Absolute Velocity) based. Last 
algorithm requires input data to be acceleration in g units. More information is available in the Appendix C. 
Triggering algorithms used by GeoDAS. 
 
The parameters of local triggers are set in the table. Most of them are specific for every triggering algorithm 
but in any case you have to specify which components of the signal are taken into account in the selected 
algorithm. It can be only one selected single component (x, y or z), any of two (x, y) or three components, or it 
can be also the vector sum of two (x, y) or three components specified in last case as square root of 
(x2+y2+z2). Up to three levels of trigger are monitored by GeoDAS. The network trigger is declared at 
exceeding of the 1st level. Two other levels are used by the alarm system only, see below.  
 
A threshold level in physical units is set as trigger level in case of the absolute level exceeding algorithm. If 
the selected algorithm is STA/LTA based then the STA/LTA ratio is specified for all supported trigger levels. 
The STA and LTA time intervals are also adjustable. CAV based algorithm requires CAV thresholds to be 
set in units of g-sec. Other adjustable parameters for this algorithm are the time interval used to calculate 
the CAV value, and the integration limit provided in g. 
 
When the network trigger becomes active, you would probably like to activate the alarm system, alerting 
about detected events. 
Enable the option 
Activate alarm 
system... to do so. The 
number of monitored 
alarm levels is specified 
in the edit box Alarm levels. You have to specify also a communication port to send alarm information out. 
The format of alarm ASCII data string: <<<ALARM LEVEL N. Date: DD.MM.YYY. Local Time: 
HH:MM:SS.ddd>>>, where N - can be 1, 2 or 3. DD.MM.YYYY and HH:MM:SS.ddd are date and time 
stamps with milliseconds. This string is sent out at the fixed baud rate 9600 baud. At the time of an alarm 
occurs, the above window comes up on the screen and an audible alarm signal is generated. The window 
remains on the screen until an operator hits the button [Close]. Pressing the button [Advanced] lets you see 
some additional information about the trigger conditions.  
 
You can also set with this dialog whether the event files must be created on any local trigger and/or on a 
network trigger. In case of a network trigger you can also specify whether all data streams must be saved to 
the event files or only those, which have the local triggers activated. The other parameters adjustable here 
are: pre- and post-event time interval and the maximum expected event duration. 
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The last group of controls specifies whether an email message or SMS notification must be sent out in case 
of a network trigger. To activate this functionality, one has to enable the corresponding options and select the 
lists of recipients with the browse buttons […]. The [Setup] of GeoDAS Messenger must be performed as 
well to provide the required operations. Refer to the Appendix F. Messenger of GeoDAS for more information 
on this topic. 

10 Off-line Data Viewer 

10.1 General Notes 
The Off-line Data Viewer (ODV) is a tool of GeoDAS intended for displaying and for the analysis of the 
waveforms recorded by GeoSIG instruments. Waveforms are kept in files, which can have different formats 
identified by the file extension: 
• GSR - standard decompressed event file format 
• GST - the same as GSR but tespulse-file 
• GBR - compressed event file format  
• GBT - the same as GBR but tespulse-file 
• GCR - standard decompressed event file format generated by GCR instruments 
• GCT - the same as GCR but tespulse-file 
• GPR - permanent recording format 
• SMR - file generated by a SMACH recorder  
 
ASCII text files are supported as well. ODV can export any currently displayed data set to an ASCII data file 
and import the same file afterwards. If an ASCII data file is created by another application, care must be 
taken that its format is compatible with the one supported by GeoDAS. Please refer to the Appendix B. ASCII 
file format used by GeoDAS for more information on this issue. 
 
ODV can also display the data stream files created from the data received with the data streams. They have 
the DAT extension by default. 
 
ODV supports the basic miniSEED format of event files. The default extension of these files is MSD. 
 
Opening an event file with GeoDAS is as simple as with other Windows applications. Just run the menu item 
File->Open or press the first button of the ODV toolbar and select a file with the standard File Open dialog. 
Besides the types listed above there are two more options selectable with the File type combo box: 
• Event files. These files are created by GeoDAS (File->Save Event) and contain the information about 

one or several event data files that have been downloaded by the instruments. It is useful to save the files 
created by several instruments but related to the same event under the single name as an "event". 

• Station files. In order to open all the files, which reside in the current directory and created by the same 
instrument, simply select the Station file from the list and click it to open. Station files have the following 
names: XXX-(N).nst, where XXX is the instrument code and N - number of files in the current directory. 

 
When opening one or several data files of any type listed above, the ODV graph window appears:  
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The above plot is a typical GeoDAS data presentation.  There can be up to three text strings at the top of a 
graph. It is a graph title, which displays the file name, the event start time and date and other important 
information. The user can enter also any comment, which will be indicated in the comment line. 

The data set shown above has three components. Every data set can have one, two or three data 
components, except the files created by GCR instruments. These files may contain a 4th component, which 
is the vector sum of all real physical components of the signal. All components of the signal have the same 
start time and therefore they are displayed with the same horizontal time axis. It is selectable with the context 
menu (item Graph) whether one, two or three components of the signal shall be displayed in the graphs for 
the multi-component data sets. The peak value and its time are indicated at the top of every graph 
component. 

The other elements of the graph window are the vertical and horizontal axes with the labels, the grid for 
every component. If more than one graph is open in the same window then several button-like controls are 
indicated at the left part of the window. Those at the top are similar to the standard buttons of any window. 
They are used to minimise, maximise, restore or close the current graph. The buttons at the bottom are used 
to go to the next or to the previous graph. The number of the graph is indicated next to these buttons. 
 

In order to optimise the space used for graphs in the window you can hide those button-like controls by 
disabling the option View Graph Control in the View submenu of the main GeoDAS menu.  
 
The total number of graphs opened in the graph window and the number of selected graphs are indicated in 
the window title. 

Many operations described further can be applied to the graphs. This is done in the following different ways: 
• By running some items of the main GeoDAS menu 
• By selecting a desirable action from the context menus of the graph window 
• By pressing the buttons on the ODV toolbar 
• With the combination of hotkeys from the keyboard 
The details of different operations are described below. 

10.2 Selection of the Graphs 
A user has the possibility to select one or more graphs in active view. In order to select/deselect just one 
graph, simply click with the mouse on the area located left of the labels of vertical graph axis. Selected 
graphs are shown with inverted colours. If the graph has several components of the signal then all of them 
are selected as one graph.  
 
While moving a mouse cursor over selected graph, the exact values of all its components as well as the 
value of X-scale are indicated at the position of the mouse cursor. 
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Several graphs can be selected from the submenu Edit of the main GeoDAS menu: 
 Select All     

 Selects all the graphs in the currently active ODV window. 
 
 Select Visible     

 Selects visible graphs, i.e. those maximised or restored 
 
 Select Minimised     

Selects only minimised graphs, i.e. those represented by their titles only as it is shown in the picture 
below. Two graphs at the bottom are minimised and the third one is restored. The middle graph is 
selected.  
 

 
In order to minimise a single graph, simply click the leftmost button-like control of the current graph. 

You can also Minimise All or Restore All graphs with the corresponding items of the View submenu in 
the main GeoDAS menu.  
 

 Unselect All      
Deselects all selected graphs 

 
 
As soon as selection is made, the various operations can be applied to the selected graph(s) with the items of the 
Edit submenu. 
 
 Delete     

Removes selected graph from the current view window and its data set from the data stack. 
  
 Cut      

Removes the graph from the view and places it to the clipboard.  
  
 Copy      

Copies the whole graph to the clipboard. 
  
 Copy Fragment    

Copies only the visible fragment of the graph to the clipboard. 
 
If one or more graphs or graph fragments were copied to the clipboard, the following operations become 
available as well: 
 
 Paste in new window    

Pastes the previously copied graph or a fragment of the graph from the clipboard to a new window. 
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 Paste    

Pastes the previously copied graph (or fragment) from a clipboard to the same view. 
 

10.3 Sorting the Graphs 
The graphs opened in the same window can be sorted. There are two options available in the View submenu 
of the main GeoDAS menu: 
 
 Sort by name      

Sorts graphs by their names as they appear in the graph headers. 
  

 Sort by Time     
Sorts graphs by their record date and time. 
 

10.4 ASCII Data Files 
The data sets displayed in ODV windows can be saved as ASCII data files. In order to do so, select the graph 
you are going to export to an ASCII file and run command for the main menu File->Export Text. This action 
results in saving the selected data set to the same directory and with the same name as the original event file 
but with the TXT extension. 
 
The format of the output file depends on the options, which are set currently for the axes of the exported 
graph: 
• The data is saved to the file as columns of data samples, one column per every graph component, which 

is currently displayed. 
• If the units of Y-scale are counts then the data samples are saved in counts as well, otherwise in physical 

units. 
• If the labels of X-scale are not set to 'None' then the time column is save to the output file. The format of 

this column is the same as indicated currently in the graph: relative time in seconds, absolute time or just 
samples.  

 
The first four strings in the file contain most important general information. The one-string title indicating the 
names of columns is always saved to the file. It has the following format: [Name of the 1st column]  
Component1,units  Component2,units ... etc. 
 
The import of ASCII files is also supported. When opening the data file with the standard browse dialog, 
select "Text data" as the type of file and choose one of the text files with the TXT extension.  
 

If an ASCII data file is created by an external routine please make sure that it has one of the formats 
supported by GeoDAS. The options are listed above. Please refer to the Appendix B. ASCII file format used 
by GeoDAS for more information. 
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10.5  ODV Context Menus  
Available context menus are shown in the picture below. They are different depending on the area where the 
user right-clicks: on the graph title, on vertical or horizontal axes or on the graph view itself. In the last case 
the context menu has the submenus, which are indicated in the same picture. 
 

 

10.5.1 Title Context Menu 

This menu allows the title information to be customised.  
 
 General Info      

If this item is selected, the following information is displayed in the first string of the title: start date and 
time of the event, number of samples and the sampling rate. The name of file is always shown 
regardless the selected options in the title menu 

 
 Extended Info     

If this item is selected, the following information is displayed in the second string of the title: station 
code name (up to three characters), type of the instrument and its serial number, pre- and post-event 
time in seconds. If the displayed data file contains information about trigger and/or alarm time, this time 
indicated in this string instead of pre- and post-event intervals: 
TH2 time: HH:MM:SS.ddd - trigger time (when the event was declared) 
TH1 time: HH:MM:SS.ddd - alarm time 
Note that this information is available only if the file is created by a special version of GSR-18 
instruments. 
Extended information for the DAT files consists of the station code, number of displayed data files and 
data blocks and the total number of the data samples in all these blocks.  
 

 User Comment...     
Selecting this item launches the simple dialog, which is used to enter any comment, which is displayed 
in the additional string of the graph header. 

 
 Peak Values      

If this item is selected, the peak values and their time are indicated at the top of graph components. 
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10.5.2 Vertical Axis Context Menu  

The commands of this menu are applied to that graph scale only, which is right-clicked. 
 
 Zoom in     

The scale of the vertical axis is resized in a way that the graphical image gets bigger. In case of a 
multi-component graph this command is applied to all components only if the Grouped option (see 
further) is active. Otherwise only the scale of a component, which was clicked, is resized. 
 

 Zoom out     
The scale of the vertical axis is resized in a way that the graphical image gets smaller. The action 
provided by this command depends on the Grouped option as it was described above.  
 

 Same Scale     
Assign the same Y-scale to all components. The scale of a component clicked with mouse will be 
taken as common scale.  
 

 Reset      
Resets the limits of the vertical axis scale to the original ones. 
 

 Auto Fit      
This option, if selected, makes the vertical scale of the graph adjusted automatically in a way that the 
visible fragment of the graph is always best fit into the window. Note that one cannot scroll and scale 
the graphs displayed with this option. 

 
 Centered     

If this option is checked, the zero line is always placed in the middle of the graph. Note that one cannot 
scroll the centered graphs. Some kinds of data graphs, e.g. Vector Sum, have only positive data 
samples and therefore they cannot be centered. There is one exception: if the graph contains only zero 
values, both positive and negative scales are displayed for better visualisation of such graphs. 

 
 Grouped     

This option specifies whether all components of a multi-component data set are scrolled and resized 
synchronously. If this option is not active those operations are applied to the one component only. 
 

 Fixed Scale     
This command sets the same fixed vertical scale for all components of the multi-component data set. 
User specifies this scale in the Graph Options window. Note that one cannot scroll and scale the 
graphs displayed with this option. 

 
 Counts/Units/None    

This group of items specifies whether the labels of Y-axis must be indicated and if so, whether they 
must be shown in physical units or in counts. 

 

10.5.3 Horizontal Axis Context Menu 

The commands of this menu are applied to that graph scale only, which is right-clicked. 
 
 Zoom in     

The scale of the horizontal axis is resized in a way that the graphical image gets more stretched.  
  

 Zoom out     
The scale of the horizontal axis is resized in a way that the graphical image gets more condensed.   
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 Reset      
Resets the limits of the horizontal axis scale to the original ones  
 

 Samples     
The labels of X-axis display the number of samples acquired from the beginning of the record  
 

 Units     
In case of the time series the X-axis is labelled with the relative seconds counted from the beginning of 
the record. The absolute start time is indicated in the header (if selected). In case of the frequency 
series the X-axis is labelled with the frequency units (Hz). 
 

 Time      
The labels of X-axis display absolute time in hours, minutes, seconds and milliseconds. Applied to the 
time series only. 
 

 None      
The X-axis has no labels at all.  
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10.5.4 Context Menu of the Graph View 

 Zoom/Scroll/Scale    
Only one of these items can be checked at a time. It specifies the default action, which is performed 
when a user holds the left mouse button pressed on the graph and moves the mouse pointer. When 
zooming, select the required fragment of a graph first and confirm your selection. Graphs are scaled in 
both vertical and horizontal directions. But the vertical scale can be changed only if the option "Auto" is 
off (see further). While scaling, you can either compress or expand the graph. All these functions are 
intuitive once and can easily be performed with a mouse only. 

 
 Graph     

If the displayed data set contains of more than one component, you can hide those, which you would 
like not to be displayed by 'unchecking' the number of corresponding component(s). With the options 
Current/All you can specify whether your selection of the graph components has to be applied to all 
graphs opened in the window or to the current one only. 

 
 Vertical Zoom    

The entire vertical graph view is scaled for 100 (default), 200, 300 or 400%. The percentage of 
zooming is selected from the next submenu. 

 
 Separate     

This item specifies how several graphs opened in one window and their components are separated 
one from the other. The following options selected from submenu are available: 
• Line. If this option is checked all components of the graphs are drawn separately, otherwise they are 

overlapped and always shown with the same scale 
• Color. Specifies whether the graph components are painted with different colours 
• Graph. If this option is enabled, then every graph in the window has its own view with the horizontal 

scale and labels. This is the default mode. Otherwise all the graphs are displayed in the same view 
as it is shown in the picture below:  
 

 
 
The graph presentation shown above differs from the default one, which was described earlier. The 
graphs have no particular titles but it is possible to specify a title for all the graphs: clicking with the 
mouse above the graphs brings on the dialog, which lets you enter the graph title.  
 
Instead of the Y-axis and the labels, the three-character station code is indicated on the left side of the 
graph. The peak-to-peak amplitude is shown on the right side of the graph for every component. 
 
All the opened graphs are not time-synchronised by default and can have different scaling since their 
data sets can be recorded at any time. Therefore instead of X-axis labels the message "Graphs are not 
synchronised" is indicated. Such behaviour appears if Auto switch in the Graph submenu is disabled. 
Otherwise the separation mode is selected automatically and only time-synchronised graphs are 
displayed with the same X-axis. 
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It is also allowed to minimise, maximise and restore the graphs as well as to select and deselect them. 
For instance, the upper graph in the picture above is shown selected. 
 

 All Scales X     
This item is used to set the options of X-scale for all the graphs opened in the current window. Most of 
the options are the same as those available in the context menu of X-axis but they are applied not to 
the one graph but to all of them in the window. The additional items are needed to synchronise several 
graphs in the window. The following types of synchronisation are available: 
• Sync Full. The minimum and the maximum limits of the time scale are selected in a way that all the 

graphs in the window are fit within this time interval. When all the graphs have the same X-axis 
(the option Separate->Graph is disabled) then the valid time is indicated with the labels of this 
axis. The start and end times of the records are shown above the graphs. 

 

 
 
• Sync Common. The minimum and the maximum limits of the time scale are selected as the start 

and end of the common time interval for all the graphs. If there is no such interval, this item is not 
available. 

• Sync Current. The graphs are synchronised within the time interval, which is currently valid for all the 
graphs shown. 

 
 All Scales Y     

This item is used to set the options of Y-scale for all the graphs opened in the current window. All 
options are the same as those available in the context menu of Y-axis but they are applied not only to 
the one graph but to all of them in the window. 

 
 Options    

This item launches the Graph 
Options setup dialog. It is the same 
as the item View->Options of the 
main GeoDAS menu. The following 
parameters are set with this dialog:  
• Colour of the graph, 

background, axes, canvas 
and text;  

• Font of the titles, axes, labels 
and other information; 

• Grid type (solid/dotted/none);  
• Whether the dots of the graph 

are connected with the solid 
line or not.  

 
In order to specify the parameters 
of X-axis and Y-axis one has to press the corresponding button and select the required options from 
the menus. Most of the options are described in the sections related to the context menus of the X-axis 
and Y-axis. Two more options can be set additionally for the Y-axis: type of the output format for the 
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labels of axis and number of significant digits. Selecting 
the option Fixed Scale shows the dialog where one can 
select the minimum and maximum limits in both counts 
and physical units for the fixed scale. 
 
When all parameters are set as desired, press the [OK] 
button to keep them as default parameters for the ODV 
graph windows. The other buttons are used to [Export] 
parameters to a file and [Import] them from this file 
afterwards. You can also reset the current parameters 
indicated in the dialog to the default ones with the button 
[Default]. 
 

 Add Data     
Adds a new data set to the graph window. The same as File->Add Data. A new file is selected with the 
standard Windows File Open dialog. 
 

 File Info     
Displays the general information stored in the header of the current data file. The operation is not 
available for ASCII text files and for the files with SMR extension. 
 
 

10.6 The ODV Toolbar 
For more convenience pressing the corresponding buttons on the ODV toolbar can perform the most often 
used operations with the graphs. The following operations are supported: 
 

  Open file.  Lets the file to be opened with the standard Windows File Open dialog. The same action is 
provided with File->Open of the main GeoDAS menu. 

 
  Add Data. Adds a new data set to the graph window. The same as File->Add Data of the main GeoDAS 

menu. 
 

  Capture Graph. Saves the graph image to a BMP, JPEG or PNG file.  A destination directory as well as 
the file name is selected with the standard Windows browser. The same as File->Capture All. 

 
  Cut Graph. Selected graphs are removed from the active window and are placed to the clipboard. The 

same as Edit->Cut. 
 

 Copy Graph. Selected graphs are placed to the clipboard without removing them from the active window. 
The same as Edit->Copy. 

 
  Paste Graph.  The previously saved graphs are inserted to the current window from the clipboard. The 

same action is provided with Edit->Paste. 
 

  Scroll Left. Current graph is scrolled left. 
 

  Scroll Right. Current graph is scrolled right. 
 

  Stretch Horizontally. The X-scale of the graph is changed in a way that the graph image is getting more 
detailed along the X-axis. 

 
  Compress Horizontally. The graph image is compressed along the X-axis. 

 
  Scroll Up. Current graph is scrolled upwards. The operation is performed only if Y-scale is not centered. 

 
  Scroll Down. Current graph is scrolled downwards. The operation is performed only if Y-scale is not 

centered. 
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  Stretch Vertically. The Y-scale of the graph is changed in a way that the graph image is getting more 

detailed along the Y-axis. 
 

  Compress Vertically. The graph image is compressed along the Y-axis. 
 

  Reset. Performs the reset of graph view to the original one. 
 

  Grid Type. Changes the grid type (solid/dotted/no grid). 
 

  Y-axis Units. Changes units of the Y-axis labels. 
 

  Normalise View. The view of X and Y-axes is normalised. Labels are displayed in the format suitable for 
printing the graphs. 

 
  Graph Options.  Pressing this button launches the ODV setup dialog. The same action is provided with 

View->Options. 
 

10.7 ODV Hot Keys 
Pressing the corresponding keys on the keyboard can also perform some operation with the graphs. These 
hot keys are summarised in the following table below. 
 
Key Action 
1,2,3,4,5,6 Number of component to be displayed (if exists) 
Tab Show next component: only 1st, only 2nd, ..., All separately, All overlapped, 

only 1st, ... 
Arrow Up Stretch the Y-scale 
Arrow Down Compress the Y-scale 
Arrow Left Shift the graph left, if not selected 
Arrow Right Shift the graph right, if not selected 
+ (plus) Stretch the X-scale 
- (minus) Compress the X-scale 
Arrow Left Move the pointer left to the next sample, if selected 
Arrow Right Move the pointer right to the next sample, if selected 
G The type of the grid (solid/dotted/no grid) 
D Separation of the graphs 
U Units of the Y-scale (Counts/Values/None) 

 
You can perform the operations of scrolling and scaling (compressing/stretching) the graphs faster if you 
press and hold the key Ctrl, Alt or Shift while pressing the corresponding hot keys used for scrolling and 
scaling. 
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11 Data Analysis 
The Data Analysis part of GeoDAS has 
been developed by GeoSIG especially 
for the strong motion, earthquake 
engineering and civil engineering data 
analysis.  

Note that the analysis functions 
work in the registered GeoDAS 
versions only, which have the correct 
nonzero registration number. 

11.1 Data Analysis Menu 

All supported math functions and other 
operations related to the data analysis 
are combined in this menu.  
 

The operations are performed with the 
graphs (data sets)  shown in the current 
ODV window. When the first math 
function is applied to the original data 
set, the current ODV window is splitted 
up in to two parts: the upper one 
displays original datasets and the lower 
one displays the analysed data. When 
the next function is applied, the lower 
part of the ODV window is updated with 
results of the last math operation. 
Several previous results are kept in a 
stack and therefore one can always cancel the results of the latest math operation and to return to the 
previous analysis results by running the Undo item of the Analyse menu. 

 Mathematical operations are applied to selected graph(s) or to the all graphs of active window if no one 
data channel is selected. 
If there were more than one data set in the original ODV window, you can quickly view list the original data 
and the results of analysis by pressing the arrow buttons at the left side of the graph windows. 
 
Some math functions (filtering, response spectra calculation) have one or more parameters, which can be 
adjusted by user prior performing a requested function, whereas some other functions (vector sum, 
integration) have no parameters. If the function has 
parameter(s), the corresponding dialog appears after 
splitting up the ODV window but before the operation. For 
instance, one can specify the cut-off frequency when 
filtering the data. When all required parameters are 
adjusted, press the button [OK] to perform the requested 
operation. Pressing the [Cancel] button cancels the 
selected operation and closes the lower part of the current 
ODV window. If the option Always use the current 
parameter by default is selected then the specified cut-off frequency will always be used by default for the 
current operation and the Filter Parameters dialog window will not appear anymore. In such a case the 
default parameter(s) can be edited through the menu item Parameters. It opens the dialog window, which is 
used to select an analysis function for adjusting its parameters. 
 
A sequence of analysis functions can be 
fixed (saved) to apply later on to any set 
of the input data. For instance, the 
following math operations are applied 
one by one: the baseline correction, 
filtering, integration and the spectra 
calculation (FFT magnitude). Left 
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clicking now the title of the analysis part of ODV window opens the context menu, which allows to Set batch 
of the performed math functions in a way that they are saved for a future use. 
 

 
The saved sequence of functions can be applied now to any input data by running the Analyse menu item 
Run Batch. 

The menu item Manual Event Check covers the specific functionality related to the seismic and OBE/SSE 
described in the section Manual Event Check. 

 

11.2 Functions of the Data Analysis 

All mathematical functions supported by the program are listed in this section. The brief description of every 
function is illustrated with an example. If the function has at least one parameter, the corresponding dialog for 
setting of those parameters is shown as well.  

Note that any combination of math operations is allowed, i.e. the program does not check the logic of working 
with different kinds of datasets. For instance, one can apply the FFT magnitude function and then one can 
perform the calculation of Cumulative Absolute Velocity (CAV), which is not correct logically and has no 
practical meaning. Therefore the logic correctness of a sequence of math functions is solely the user’s 
responsibility.  

Several operations are valid only when applied to a particular kind of input data. For example, the CAV 
calculations are correct only for the input acceleration data in g units. 
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11.2.1 Lowpass Filter  

A 6th order (3 times 2nd order) Butterworth Lowpass Filter is applied.  
 
User-defined parameter: 

• Cut-off frequency in Hz 
 

 

11.2.2 Hightpass Filter  

A 6th order (3 times 2nd order) Butterworth Highpass Filter is applied.  
 
User-defined parameter: 

• Cut-off frequency in Hz 
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11.2.3 Baseline correction 

This function performs a baseline correction over the whole data set. The correction method can be one of 
the followings: 

• Using PreEvent samples only. This calculates the average signal level in the pre-event time and 
subtracts this from the entire data signal. User specifies the number of pre-event samples. 

• Using the whole data record. Default method. This calculates the average signal level of the whole 
event and subtracts this from the entire data signal.  

• Using PreEvent samples then the whole record. This calculates the average signal level in the first half 
of the pre-event and subtracts this from the pre-event part of the signal and then calculates the 
average signal level of the rest of the event and subtracts this from the rest of the data signal. User 
specifies the number of pre-event samples. 
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11.2.4 Integration 

This function integrates acceleration data to the velocity or from velocity to the displacement. No correction 
algorithms are used by the integration function; therefore better results can be obtained by performing the 
baseline correction or by filtering the data prior to integration. 
 
The result of a double integration (from acceleration to the displacement) must be analysed rather critically as 
integration offset levels must be assumed to be zero. 
 

 
 

11.2.5 Differentiation 

This function performs differentiates of the original data set. It is used usually to convert the velocity data to 
the acceleration.  
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11.2.6 Vector Sum 

This function calculates the vector sum of three data components. 
 

 
 

11.2.7 Cumulative Absolute Velocity (CAV)  

This function calculates the Cumulative Absolute Velocity of the data by using one-second data windows, with 
a specified integration level. Note that the input data must be in g units. Only in this case the calculations are 
performed correctly. The CAV is presented in the units of mm/s. 
 
User-defined parameter: 

• Integration limit in g 
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11.2.8 Time-domain Filtering 

This function applies a window filter to the source data. The window type is one of the followings: Parzen, 
Hanning, Hamming, Welch, Blackman, Lanczos or Gauss. 
 

 
 

11.2.9 Effective Values 

This function calculates effective values of the signal by using sliding windows in the time domain according 
to DIN 45669. 
 
User-defined parameter: 

• Time constant defining the sliding window length, in seconds 
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11.2.10 Damping 

This function calculates the damping factor and natural frequency of the input signal in the time domain. 
 

 

11.2.11 Power Spectra 

This function performs a power spectrum calculation on the time series. The resulting function is normalised 
in a way that it indicates how much power is per frequency interval. Input data array is divided into several 
data chunks, each of them has the specified number of samples (power of 2).  The chunks may overlap if 
specified by the user. The FFT function is applied to every data chunk, and then the result is averaged. 
 
User-defined parameters: 

• Number of samples in every data chunk 
• Overlapping factor: no overlapping, 50% or 67% 
• Whether a window function is applied to the input time series, and if yes – which one 
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11.2.12 FFT Magnitude 

This calculates the FFT Magnitude. The resulting spectra is normalised by 1/N factor. Input data array is 
divided into several data chunks, each of them has the specified number of samples (power of 2).  The 
chunks may overlap if specified by the user. The FFT function is applied to every data chunk, and then the 
result is averaged. 
 
User-defined parameters: 

• Number of samples in every data chunk 
• Overlapping factor: no overlapping, 50% or 67% 
• Whether a window function is applied to the input time series, and if yes – which one 
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11.2.13 Terzband Spectra 

This function calculates the peak values of the data signal when it is passed through the equally spaced 
band-pass filters in the time domain. The type of peak values selected by user can be one of the followings: 

• Max. Amplitude: The maximum value of raw signal is displayed (Max-Hold on raw signal)  
• RMS Amplitude: The RMS value of the raw signal is displayed (RMS-Fast on raw signal)  
• Max. Effective Value: The effective value function is applied to the raw signal before calculating of 

the maximum value 
• RMS Effective Value: The effective value function is applied to the raw signal before calculating 

the RMS value 
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11.2.14 Response Spectra 

This function performs a response spectrum analysis on the data. The output data can be the Response 
Spectrum Acceleration (RSA) or the Response Spectrum Velocity (RSV) or the Response Spectrum 
Displacement (RSD). The user can select the integration method for RSV and RSD between integration in 
the frequency domain and the integration in the time-domain. Integration in the time domain for RSV (double 
integration for RSD) is performed prior to the response spectra calculation. 
 
User-defined parameters: 

• Start (lowest) frequency of the resulting spectrum in Hz 
• End (highest) frequency of the resulting spectrum in Hz 
• Damping factor, always < 1, i.e. damping of 5% is specified as 0.05 
• How many points per decade are calculated in the resulting signal 
• Type of the output spectra and the integration method for RSV and RSD selected from the list  
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11.3 Templates 
Templates are developed for effective analysis of the big amount of similar data. Let us consider an example 
for better understanding of this issue. Suppose we have many event files, which contain acceleration data, 
and we need to analyse their spectra and to receive also the vector sum of every data file. Further all these 
files shall be printed along with the results of analysis. 
 
First step is to create the corresponding template using one data file. The required actions are listed 
below: 
1. Open the same file three times in three different windows 
2. Apply the FFT Magnitude function with the required parameters to the input data in 2nd window 
3. Close the upper part of window (Input data) and select the remaining results of FFT Magnitude by clicking 

the graph canvas 
4. Press the Copy button on the toolbar (or execute Edit->Copy), close 2nd window, activate the 1st window 

and press the button Paste (or Edit->Paste). First window contains now the original graph plus the result 
of the FFT Magnitude operation 

5. Apply the Vector Sum function to the input data in 3rd window 
6. Close the upper part of window (Input data) and select the remaining result of Vector Sum by clicking the 

graph canvas 
7. Press the Copy button on the toolbar (or execute Edit->Copy), close 3rd window, activate the 1st window 

and press the button Paste (or Edit->Paste). First window contains now the original graph plus the result 
of the FFT Magnitude and Vector Sum operations 

8. Set the required order of graphs by using the arrow buttons at the left side of the graphs. For instance, 
you would probably like to exchange graphs to have the result of Vector Sum at the top 

 
Now you can adjust the properties of the graphs. For instance, you would probably like to set the option 
Grouped for the Y-scale of the original graph in order to display all three components with the same scale. 
 
The resulting window looks now as following: 
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Now it is the time for a next step: to 
save this customised ODV window 
as a template. This is done with the 
menu item Analyse->Templates->Save 
Current View as Template. The dialog 
Template Parameters comes up. The 
window Structure of the template lists 
all the graphs with their parameters, if 
any. Enter a name of the template and 
press the button [Save]. The newly 
created template is stored with all 
currently assigned parameters. This 
name appears from now on in the list of 
templates under the submenu Analyse-
>Templates. The same dialog is used to 
delete templates when they are not 
needed anymore. In order to delete a 
template, run the menu item Analyse-
>Templates->Delete Templates, select from the list a name of the template you wish to delete and press the 
button [Delete]. The button [Copy] copies selected text strings in the window Structure of the template to the 
system clipboard. 

From now on the new template can be used to process and analyse the data. For instance, one can open 
many data files at once and apply the template to all opened files by running the menu Analyse->Templates-
>FFT and Vector Sum. All data files in the current ODV window will be processed, the results of the FFT 
Magnitude and Vector Sum operations will be placed to the same window and all the graphs are sorted 
correspondingly so one can easily view them and take the printouts. 

 

 

 

 

 

 

12 The Other Capabilities of GeoDAS  
The general functionality of GeoDAS described in the previous chapters is used in most applications based 
on GeoSIG equipment. But GeoDAS has also several special features, which are required for particular 
applications or can be activated in some special cases only. Therefore the sections describing all these 
functionalities are not included to the standard manual but can be provided as separated appendixes for the 
special applications or by the user’s request. 
 
Appendix E. Strong Motion Data Processing 
Appendix F. Messenger of GeoDAS 
Appendix G. Network Links of GeoDAS 
Appendix H. Statistics of Communications 
Appendix I. Monitor Mode of Operation 
Appendix J. Event Checks 
Appendix K. Station Map 
Appendix L. Support for ADC boards 
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13 Appendix A. Information on LSB 
 
The Gain Position, Full Scale and LSB Value (Resolution) 
 
The “LSB Value” (LSB = Last Significant Bit) represents the value of 1 raw digital count. The 12-bit recorder 
describes maximum 4096 digital counts (± 2048 digital counts) and the 16 bit recorder maximum 65536 
digital counts (± 32768 digital counts). 
The LSB value is calculated by:     

   R 
 LSB = ______ R = 2 times full scale range of sensor  
    2(Number of Bits) 

Enter the LSB Values for each channel and for each gain position. These values are given in the sensor 
calibration sheet. 
 
The typical LSB values for a velocity sensor and 12 Bit are: 

 Gain Position  Full Scale LSB Value (Resolution) 
 Gain 0 ± 100 mm/s 0.0488282 mm/s 
 Gain 1 ± 10 mm/s 0.00488282 mm/s 
 Gain 2 ± 1 mm/s 0.000488282 mm/s 
 

The typical LSB values for the acceleration sensor and 12 Bit are: 
 Range, g LSB Value  
 2 9.76563e-4 g 
 1 4.88282e-4 g 
 .5 2.44141e-4 g 
 .25 1.22070e-4 g 
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14 Appendix B. ASCII file format used by GeoDAS 
If an ASCII data file is created by any external application for importing this file to GeoDAS for the off-line 
data analysis the format of ASCII file must be compatible with one used by GeoDAS.  
 
The main rules are listed below: 
• An ASCII file must have the extension "txt"; 
• The four-string header shown in the example below is mandatory. The key words of this header must 

contain underscore character instead of spaces between words (for instance, "Start_date"); 
• The data values of every component (data channel) are saved in separate column; 
•  The one-string title indicating the names of columns is mandatory. It must have the following format: 

[Name of the 1st column] Component1,units  Component2,units ... etc. 
• The "Name of the 1st column" can be one of the following: 

- Time is used for absolute times in the format hh:mm:ss.ms, example 1 
- Time:sec is used for relative times (seconds from the start time), example 2  
- Samples is used just to count the samples (string numbers), example 3 
- The name of 1st column can be omitted, i.e. only component columns exist in the file, example 4  

• If the unit names are "Counts", it is supposed that the data values are provided in integer format 
(example 2)  

 
===== Example 1 
Station_code    STA 
Sampling_rate   200.0000 
Start_date      24.01.2002 
Start_time      22:59:58.824 
Time   Long.,g    Tran.,g    Vert.,g   
22:59:58.824  -2.0704e-003    2.3823e-003    4.0054e-005   
22:59:58.829  -2.0514e-003    2.3937e-003    3.4332e-005   
22:59:58.834  -2.0685e-003    2.3813e-003    2.7657e-005   
22:59:58.839  -2.0409e-003    2.3727e-003    2.8610e-005   
 
===== Example 2 
Station_code    STA 
Sampling_rate   200.0000 
Start_date      24.01.2002 
Start_time      22:59:58.824 
Time:sec   Long.,Counts    Tran.,Counts    Vert.,Counts   
0.0000e+000    -2171         2498         42          
5.0000e-003    -2151         2510         36          
1.0000e-002    -2169         2497         29          
1.5000e-002    -2140         2488         30          
 
===== Example 3 
Station_code    STA 
Sampling_rate   200.0000 
Start_date      24.01.2002 
Start_time      22:59:58.824 
Samples   Long.,g    Tran.,g    Vert.,g   
0            -2.0704e-003    2.3823e-003    4.0054e-005   
1            -2.0514e-003    2.3937e-003    3.4332e-005   
2            -2.0685e-003    2.3813e-003    2.7657e-005   
3            -2.0409e-003    2.3727e-003    2.8610e-005   
 
===== Example 4 
Station_code    STA 
Sampling_rate   200.0000 
Start_date      24.01.2002 
Start_time      22:59:58.824 
  Long.,g    Tran.,g    Vert.,g   
 -2.0704e-003    2.3823e-003    4.0054e-005   
 -2.0514e-003    2.3937e-003    3.4332e-005   
 -2.0685e-003    2.3813e-003    2.7657e-005   
 -2.0409e-003    2.3727e-003    2.8610e-005   
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15 Appendix C. Triggering algorithms used by GeoDAS 
Several algorithms are used by GeoDAS to declare an event trigger for every monitored data channel 
received with data streams. They are handled by the Data stream manager and can be set through the main 
menu Settings -> Data Streams. 
 
1. Absolute Level Exceeding 
This algorithm permanently compares the signal amplitude to a threshold value. The trigger is declared when 
the amplitude exceeds the pre-set threshold value. This algorithm is the simplest one. No data averaging is 
performed and no additional conditions are set. Every single sample of high amplitude can cause activation of 
the trigger. Therefore in order to avoid false triggers due to accidental spikes it is recommended to filter the 
signal to remove harmonics of high frequencies before analysing this signal by the triggering algorithm. Other 
important issue is that the DC offsets from all data channels must be continuously monitored and removed. 
 
 
2. Algorithm based on STA/LTA ratio 
The STA/LTA (Short Time Average/Long Time Average) ratio trigger computes the short term and long term 
averages of signal. When the STA exceeds a pre-selected multiple of the LTA, the event is declared. The 
advantage of this trigger type is that the trigger sensitivity adapts to the seismic background signal. With an 
increasing noise level the trigger sensitivity decreases and therefore less false triggering occur.  
 
To use the STA/LTA ratio trigger, the following information must be supplied: 

- the short term time period; 
- the long term time period (may not be set smaller than the STA); 
- the ratio of short term average to long term average which will declare an event 

 
The probability of having a false trigger due to noise can be minimised if a long STA averaging time is 
selected. Obviously, the STA should not be chosen longer than the shortest event of interest. In addition, the 
STA should be shorter than the block of pre-event data stored in the Pre-event Memory. If not, the initial 
portion of an event may not be recorded. 

The average period for the LTA should be chosen short enough to adapt to any changes in the level of 
background noise. However, the LTA time should be long compared to the STA time, otherwise, the LTA will 
adapt to an event as if it was simply a change in the background noise level. 
 
 
3. Algorithm based on Cumulative Absolute Velocity 
It is supposed that the incoming data channels deliver acceleration in g units. The Cumulative Absolute 
Velocity (CAV) is computed for only those 1-sesond intervals where peak acceleration is greater than an 
integration limit (usually 0.02g) using the following algorithm: 

 
          CAV (t) = Integral from 0 to t [abs(a) dt ], where 
 

a - is the sampled acceleration in g;  
dt - is the sampling interval in sec; 
CAV is counted in g-sec. 
 
The important parameter required for the analysis of continuos data streams is the total time interval to 
calculate the CAV, which is specified as last N seconds of received input data. 
Other parameter, which must be specified for this algorithm is the integration limit mentioned above. For 
most of application the default value is 0.02 g.  
The last parameter is the CAV threshold itself. When any calculated CAV exceeds this threshold value, an 
event is declared. 
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16 Appendix D. Format of the status files 
GeoDAS creates few status files during its continuous work with the configured stations. These files are 
described below. 

16.1 Results of the instrument self-tests 

Location GeoDAS_home_data_directory\StatusFiles\StationInfo 
Filename Selftest_Results_yyyy.csv where yyyy is the current year 
Format  CSV (comma-separated values) 
Structure The results of every test are packed to the single line, which consists of the following data: 

1. Station name. The name of tested station (instrument)  
2. Whether the test was performed: either ‘Tested’ or ‘Test Error’ 
3. Date of the test completion 
4. Time of the test completion 
5. Results of tests for Analog part, Hardware, Clock, Voltage, Memory. The results can be 

Ok, Error, Warning or Skipped. In the last case it means that the corresponding test 
action was not selected by user and therefore not performed 

6. Error and Warning flags in hex format 
7. Description of the code returned by the test command. It is “Processed OK” if the test 

was performed correctly, otherwise an error description is given. 
Example  
Station;Result;Date;Time;Analog;Hardware;Clock;Voltage;Memory;Error Flags;Warning Flags;Test Result Code; 
TEST2;Tested;24.04.2003;21:31:17;Skipped;Ok;Ok;Ok;Ok;[000000000000];[000000000000];Processed OK; 
TEST1;Tested;24.04.2003;21:34:50;Ok;Ok;Ok;Ok;Skipped;[000000000000];[000000000000];Processed OK; 
GBD;Tested;05.05.2003;21:38:13;Warnings;Ok;Ok;Ok;Ok;[000000000000];[180000000000];Processed OK; 
TEST1;Tested;12.05.2003;21:37:15;Ok;Ok;Ok;Warnings;Ok;[000000000000];[000000002000];Processed OK; 
GSR18;Tested;12.05.2003;21:40:14;Ok;Ok;Ok;Warnings;Ok;[000000000000];[000000002000];Processed OK; 

16.2 Status file of the annunciation actions 

Location GeoDAS_home_data_directory\StatusFiles\Annunciation 
Filename Events_<annunciator_name>_yyyy.csv where yyyy is the current year 
Format  CSV (comma-separated values) 
Structure The information about every annunciation action (event) is written to the single line, which 

consists of the following data: 
1. Date of the event 
2. Time of the event 
3. Site (station), which the event belongs to. If it is an ‘internal’ event of annunciator (e.g. 

the declaration of an alarm), the annunciator’s name is given here. Otherwise it is the 
name of a station connected to annunciator and the number of channel for this station  

4. Event description 
5. Error status of all stations connected to annunciator, their AC power errors and the link 

errors. The symbol dash (‘-’) means NO ERROR state, the asterisk (‘*’) indicates an 
ERROR. There are 8 characters in the line. They correspond to 8 annunciator channels, 
from 1st to 8th. For instance, the record --*----- means that the station connected to the 
3rd cahnnel experinces an error 

6. Status of four annunciator alarms: TRIGGER, OBE, SSE, ERROR (from left to right) 
Example  
Date;Time;Site;Event;Status;AC power;Link;Alarms; 
05.05.2003;16:11:49;ANNUN;GeoDAS Startup;--*-*---;--------;--------;*---; 
05.05.2003;16:12:08;GBD (1);ERROR;*-*-*---;--------;--------;*---; 
05.05.2003;16:13:42;GBD (1);NO ERROR;--*-*---;--------;--------;*---; 
05.05.2003;16:20:57;ANNUN;OBE Alarm;--*-*---;--------;--------;**--; 

16.3 Logfile of the instrument errors 

Location GeoDAS_home_data_directory\StatusFiles\StationInfo 
Filename StationErrors_Current 
Format  CSV (comma-separated values) 
Structure The information logged to this file is eaxcly the same as shown in the Stations: General 

Information window. The error and warning flags are placed at the end of every status line. 
Every new status line is added to this file when the error status of a particular station is 
changed. 
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17 Appendix E. Strong Motion Data Processing 
The GeoSIG GSR-18 instruments can provide parametric information containing the peak values and 
spectral characteristics of the shaking parameters. This information can be used to estimate the intensity of 
the shake in those points where instruments are located and to create a distribution of these parameters 
throughout the area monitored by several or many instruments. Such a processing is performed by another 
application and therefore GeoDAS is only responsible to acquire the parametric information from all 
configured stations and to deliver this information to that application. 
 
The main processing parameters are configured with the following dialog, which is launched from the main 
menu Settings->Strong Motion Data. As one can see from the picture, there are two ways of data delivery 
to a processing 
application. The strong 
motion parametric data 
(reports) can be saved to 
a local file in a directory 
on user’s choice or/and 
they can be send 
directly to the 
processing application 
through Windows 
sockets. Press the 
button [Browse…] to 
select a directory and the 
button [Configure…] to 
configure the module 
“SM Data Source” as it is 
described in the 
Appendix G. Network 
Links of GeoDAS. This 
module is responsible for 
delivering the parametric 
information to the 
consumers. The vertical 
component of parametric 
information is not used 
for estimation of the 
shake intensity. But you 
can select how the 
horizontal components 
are used: either average 
value of x,y is taken or 
maximum of them. 
 
As a rule, the most important parametric information is generated under real conditions rather seldom (such 
as in case of a strong earthquake), it is important to provide the simulation options for a data processing 
application. The dialog window shown above lets you simulate the parametric information in a flexible way. 
First activate the option Simulate strong motion data reports… and the other controls become available.  
 
It is assumed that many instruments are installed in the area of monitoring. The simulation takes also into 
account that the parametric reports are delivered to GeoDAS with SMS messages from the stations. The 
selection of Simulation Type depends on what must be achieved by this simulation. If the main purpose is to 
test the data processing algorithm, then GeoDAS can simulate the reports internally. If it is important to test 
also the receiving part of the system, one can simulate the reports and send them out by SMS with the 
GeoDAS SMS Manager. The third type of simulation allows the functionality of the instruments installed in the 
field to be tested. In order to do so, you have to set all the other simulation parameters and send them to the 
instruments of your station network by pressing the button [Send]. Note that there are two options available: 
you can either send the same parameters to All Stations or you can also send specific parameters to any 
single station by selecting its name from the list. The stations will perform the simulation at specified 
time. 
 

 



GeoDAS_Manual.doc/03.09.2003  GeoSIG Ltd. 
GeoDAS Software Manual  Page 17-40 

The Time Schedule specifies the time of first simulation as well as the time interval to repeat this action 
and how many times the simulation must be performed. The other parameters are the total event duration 
and the time interval to send the EVT (event detected) messages. 
 
The Station Locations can be either the real ones, i.e. the locations of the existing configured stations 
can be used for simulation or you can specify any model configuration of the station with a configuration 
file. The file is selected from any directory with the browse button […]. The format of this file is the same as 
described in the Appendix K. Station Map for the file all_stations.lst. 
 
You can also choose between the random resulting distribution of shaking parameters and the gradient 
distribution. In the last case the direction of the seismic wave propagation must also be set.  
 
With the last group of controls one can set the lower and the upper limits for the following parametric 
information: PGA (peak ground acceleration), PGV (peak ground velocity) and the spectral displacements 
at four different fixed frequencies. You are fully responsible for the correctness of this information. GeoDAS 
accepts any data without special checks and generates the random values for all stations within the specified 
limits. 
 
If it is necessary to provide some fixed customised parametric information for simulation, one can create a 
text file containing this information for all configured stations, enable the option Load parametric 
information from the file and enter the name of the prepared file or select it wit the browse button […]. 
 
When all parameters are set correctly, simply press the [OK] button to save them. If you have enabled the 
simulation option, then the first simulation will be performed at specified time. 
 

The strong motion data processing options of GeoDAS are adjusted currently for the GeoSIG Rapid 
Response Mapping application. Please contact us in case of any questions related to this application.  
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18 Appendix F. Messenger of GeoDAS  
This is a tool, which is used to deliver different types of information from GeoDAS to the subscribers. Two 
ways of delivery are currently supported: email and SMS (short message service).  
 

In order to provide the SMS service, any GSM modem must be connected to a serial port of the 
computer. Short messages are sent through this local GSM modem only. Sending SMS through the public or 
restricted Internet services of GSM providers is not yet supported.  
 

While sending an email out, GeoDAS does not connect directly to the POP3 and IMAP email servers. It 
utilises instead the MAPI service provided by the default email client installed in Windows. Therefore if order 
to use this functionality, you have to configure first any email client (such as Microsoft Outlook Express). 
 
Parameters of the GeoDAS 
Messenger are adjusted with the 
following dialog, which is launched 
from the main menu Settings-
>Messenger. 
 
Check the options of the General 
Settings to enable the 
corresponding service. In case 
you enable the SMS service, the 
communication port where GSM 
modem is attached to must be 
chosen from the list. 
 
Messengers of the different instances of GeoDAS located in the different computers can exchange with the 
data. Those messengers, which do not have the corresponding services enabled, still can send the emails 
and SMS by forwarding them to the “master” Messenger. In this case both master (which has the services 
enabled and can provide them) and the slave messengers (which have the corresponding services disabled) 
must be configured for the network communication. Press the button  [Configure…] for the corresponding 
service to perform such a configuration. 
 
The functionality of the Messenger can be 
tested at any time. Pressing the button 
[Test Functionality of the Messenger] 
launches the following dialog.  
 
In order to test the SMS service 
functionality type any text message (up to 
138 characters) and the mobile telephone 
number. Then press the button [Send]. If 
the message arrives everything works 
correctly. 
 
In order to test the email service 
functionality type the e-mail address 
where you can receive a message from 
and press the button [Send test e-mail 
to:]. You can also attach any file to your 
test e-mail. 
 
There are two more miscellaneous 
options in the Messenger Setup dialog. You can enable sending the system Log protocol by email daily. 
The list of subscribers containing the destination email addresses is selected with the browse button […]. 
The format of files containing email addresses and the mobile telephone numbers for sending the SMS 
messages is described below. 
 
The other option specifies an alternative method of delivering the SMS messages to GeoDAS. Usually it 
receives the SMS directly from GSM modems. But they can also be delivered in any other way, for instance, 

 



GeoDAS_Manual.doc/03.09.2003  GeoSIG Ltd. 
GeoDAS Software Manual  Page 18-42 

through the FTP or HTTP service and received by another application. Further all these messages are 
dumped into the files and GeoDAS picks them up from there. This will take place if you enable the option 
Scan for SMS… The directory where the files are kept is selected with the browse button […]. 
 
Address Files of the GeoDAS Messenger 
 
Messenger of GeoDAS works with two types of messages: emails and the SMS messages. The names of 
the lists of recipients must be provided for every type of messages in the corresponding setup dialogs. These 
lists are simple text files. 
 
Every line of the list of e-mail recipients must have the following format: 
<Name of the Recipient> <its@email.address.com> 
 
For instance: 
GeoSIG_Info_Service info@GeoSIG.ch 
 
The name of recipient is optional. 
 
The lists of email recipients must have the extension “LST”.  
 
Every line of the list of SMS recipients must consist just of the telephone number of a message recipient. 
International format of phone numbers is preferable 
 
The lists of email recipients must have the extension "PHN". 
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19 Appendix G. Network Links of GeoDAS 
GeoDAS can communicate to other instances of itself as well as to other applications developed by GeoSIG 
through Windows sockets. In order to set up the network communication parameters of GeoDAS the 
following dialog must be launched from the main menu Settings->Remote Links.  
 
First you have to select the option Enable 
network communication to the remote 
applications, then the other controls become 
available. 
 
The following parameters must be specified for 
both local and the remote GeoDAS 
applications: network name of the application, 
password to access it and the IP address of 
the computer where the application resides. 
 
If it is supposed that the local instance of 
GeoDAS will accept the requests from 
remote instances of GeoDAS and/or from other 
applications, simply enable the corresponding 
option and enter the port, which will be used by 
the remote applications to connect to this local 
GeoDAS. You can also apply the restrictions for 
the remote requests by enabling the option 
Accept requests from configured 
applications only. This means that only those applications listed in the Configured remote applications 
table will be accepted to connect. The option Support datagram broadcasting is required to be enabled if 
you are going to forward the information provided by data streams to the remote applications. Refer also to 
the issue Processing Stream Data for more information. 
 
Except those settings, which were mentioned already, the following parameters must be specified for every 
remote application: its server port and two timeout intervals. If a connection is not established within the 
Connection timeout interval, then GeoDAS retries to connect. If there is no data transfer through the 
existing connection during the Inactivity timeout interval, this connection is closed by GeoDAS. 
 
When all the parameters for the new remote application are set correctly, you can add it to the list of 
configured applications by pressing the button [Add]. In order to remove a remote application form the scope 
of network communications, select it from the list and press the button [Remove]. 
 
Press [OK] button to save all the changes you made and to exit from the configuration of the network 
communications. Note that you have to restart GeoDAS in order to the new settings take effect. 
 
If you have the remote applications configured with the above dialog, you can specify the details of network 
communications between the program modules. This procedure is performed locally while configuring the 
corresponding module. For 
instance, if you would like the local 
Messenger of GeoDAS to 
exchange with the SMS messages 
with the Messengers of the remote 
GeoDAS, press the corresponding 
button while configuring the 
Messenger. The following dialog 
will appear. 
 
Here you can specify whether the 
information is sent to and/or 
received from the remote 
applications by enabling the 
corresponding options. The remote applications configured with the described above dialog are listed in both 
sending and receiving lists. Those applications selected for communication must be marked with asterisks 
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by double-clicking their names in the list. If you have decided to accept the data from any application, which 
is connected to the local GeoDAS successfully, then no selection is required in the receiving list. 
 
The button [Configure] brings you to the procedure of configuration of the network communications, which 
was described above. Press the [OK] button to save all the changes you made and to exit from the 
configuration of the network communications of a local program module. Note that you have to restart 
GeoDAS in order to the new settings take effect. 
 

 The same dialog is used to configure any other modules, which participate in the network 
communications. 
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20 Appendix H. Statistics of Communications 
GeoDAS can acquire some statistical information while communicating to the configured stations. This 
information can be used to optimise communication parameters for the purpose of debugging. Statistics 
setup launched from the main menu Settings->Statistics allows this feature to be activated. 
 

20.1 Parameters of the Statistics  

If you enable keeping the statistics of 
communication, the other options become 
available. Statistical information is kept in the 
file, which is updated every update interval 
minutes, i.e. the new line of information 
containing data for the above period is added 
to this file. As soon as the report interval 
has elapsed, the total statistical figures are 
calculated, the file is closed and the new file 
is created. The completed file is sent by e-
mail to the subscribers according to the List 
of recipients if the option Send 
periodically… is enabled. Statistical files are 
kept on the hard disk as long as specified 
with the keeping interval parameter. 
 
You can also specify whether more detailed information must be gathered and send by email (if enabled) by 
selecting the following options: information on file downloads, on logins to the instruments and about 
received SMS if your instruments support them. 
 
The button [Messenger Setup…] provides the same functionality as the menu item Settings->Messenger. 
Pressing the [OK] button saves all the changes you made and exits from the Statistics Setup. Note that you 
have to restart GeoDAS in order to the new settings take effect. 
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20.2 Statistics Window  
Statistical information, if enabled, is displayed in the following information window: 

Statistical information displayed in the window is described below: 
Station The unique station name, which is entered while adding a station. This name is used by 

GeoDAS only and is not stored in the instrument memory  
 

Logins Number of successful logins to the instrument. The first value is a number of logins during 
the current update interval. The second value is the total number of logins during the 
report interval. The same style of indication is applied to the number of downloads and 
messages (see below). 
 

Online Time Total time interval when GeoDAS was logged in to the instruments. Indicated in seconds 
 

Downloads The number of downloaded files and their total size 
 

Transfer Rate The rate of data transfer from the instrument. Three values are indicated: minimum, 
maximum and the mean value over the report interval. The same style of indication is 
applied to the next two columns 
 

Get Channel Three values (minimum/maximum/mean) indicate how long GeoDAS was waiting for a 
free communication channel to lock it and get an access to the current station. Indicated 
in seconds 

Connect Again three values display how long it was taken to dial out (in case of a dial-up channel 
only) and to connect to the instrument. 
 

Failed Logins Number of attempts to login to the instrument, which failed 
 

EVT Message Number of EVT (event detected) messages received during the current update interval 
and the total number of them received during the report interval 
 

FIL Message Number of EVT (event completed) messages received during the current update interval 
and the total number of them received during the report interval 
 

SOH Message Number of SOH (state of health) messages received during the current update interval 
and the total number of them received during the report interval 
 

 
GeoDAS resets the statistical information each time when the report interval elapses. 
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21 Appendix I. Monitor Mode of Operation 
The monitor mode is used in multi-computer configurations only. A GeoDAS application installed as monitor 
can control other GeoSIG applications and can provide general information about them to the subscribers by 
email an/or by SMS messages. In order to install GeoDAS in this mode you have to choose it during the 
Application Installation. Note that GeoDAS cannot communicate to the instruments if it is installed in the 
Monitor mode 
 
The other instances of GeoDAS communicate to the Monitor through Windows sockets and therefore the 
remote links must be configured. 
 
GeoDAS displays the following information windows in the Monitor mode: Logger, General Information and 
the Statistics of communications (if enabled). Additionally one more information window becomes available: 
Network Monitor. 

21.1 Network Monitor Setup 
The parameters of the Network Monitor are set with the setup dialog, which is launched from the main menu 
Settings->Network Monitor. 
 
First Enable network monitor, then the other options become available. The applications to be monitored 
are selected with the standard dialog of the network module links, which is launched with the button 
[Select…]. The Network monitor 
periodically checks the status of 
applications, according to the time 
interval, which is set in the dialog,. The 
status information is also logged to the 
status file at specified time as often as 
it is set in the same setup dialog. 
 
The Network Monitor can send 
information about monitored 
applications by email and/or by SMS if 
the corresponding services are 
supported and enabled. Press the 
button [Messenger…] to make the 
required settings of the messenger 
options. You can select to send an SMS 
notification message if any monitored 
application does not respond within the 
specified time interval. The list of 
recipients can be in any directory. It is 
selected with the browse button […]. 
The same notification can be send by 
email also with more detailed information attached. The status of applications can be also send by email 
periodically if the corresponding option is activated. 
 

 



GeoDAS_Manual.doc/03.09.2003  GeoSIG Ltd. 
GeoDAS Software Manual  Page 21-48 

21.2 Network Monitor Window 
The following window appears in the screen when the Network Monitor is activated. It displays the information 
described below. 

 
Net Name The name of the remote application as it is assigned while configuring the remote links. 

The bitmap to the left indicates the status of application: green color - Ok, red color - does 
not respond, orange color indicates that the request is being processed 
 

IP Address IP address of the computer where the monitored application resides 
 

Last Restart Time of the last restart of the application. If the application never responded, then 
"Unknown" is indicated. The same is for the other columns also. 
 

Last 
Heartbeat 

Time of the last response from the application 
 

Offline Total time interval when it was not possible to communicate to the application 
 

Net Modules Number of the modules of the monitored application, which communicate over the 
network  
 

Connections Number of connections, which are currently active 
 

Free Memory The percentage of the free memory 
PhysMemory The total amount of physical memory and the amount of free memory available. Provided 

in kilobytes. 
 

VirtMemory The total amount of virtual memory and the amount of the free virtual memory available. 
Provided in kilobytes. 
 

HDD Space The total amount of HDD space and the amount of the free space available. Indicated in 
megabytes. 
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22 Appendix J. Event Checks 
The event files are analysed by GeoDAS in order to check whether they can be declared as seismic ones and 
whether they meet the Operating Basis Earthquake (OBE) and Safe Shutdown Earthquake (SSE) criteria. 
These checks are required for the applications of the Nuclear Power Plants (NPP) seismic instrumentation. 
The main role of such instrumentation is the prompt evaluation of seismic response of the safety-significant 
plant features after an earthquake. The analysis parameters are selected based on the following Standards 
and the Regulatory Guides: 
• NRC Regulatory Guide 1.12, “Nuclear Power Plant Instrumentation For Earthquakes”, Revision 2, March 

1997 
• NRC Regulatory Guide 1.166, “Pre-earthquake Planning and Immediate Nuclear Power Plant Operator 

Postearthquake Actions”, March 1997  
• EPRI TR-100082-T2, “Standardization of the Cumulative Absolute Velocity”, December 1991 

22.1 Event Check Parameters 

They are set and adjusted with the dialog window launched through the main GeoDAS menu Settings -> 
Event Checks. The parameters specified here are used for both manual check of single even files (Analyse 
-> Manual Event Check) and for automatic check of the group of event files provided by several stations and 
declared as the single seismic event. 
 

 
 
The first group of parameters called “Seismic Check Parameters” specifies the criteria used to check 
whether an event is seismic one. Two parameters (Minimum duration of the event and Maximum 
frequency of FFT peak) are applied to every event data file. The other two parameters are used during the 
automatic analysis of several event files. In order to declare such event as seismic, the number of these files 
must be equal or greater the Minimum number of sites triggered and all the event triggers must be 
declared within a Time frame for all triggers. 
 
If an event is declared seismic, it is checked for OBE and SSE criteria. The group “Parameters of 
Calculation” sets several important parameters used for calculation of the response spectrum acceleration 
(RSA), response spectrum velocity (RSV) and the cumulative absolute velocity (CAV) as these data used in 
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the Boolean formula for calculation of OBE and SSE: OBE = (RSA or RSV) and CAV. The calculation 
parameters are: 
• Response spectrum range. It is fixed between 0.1 and 100 Hz. Both RSA and RSV calculations are 

performed within this frequency range; 
• The number of frequency points per decade is usually not more than 120. This parameter is also 

applied to both RSA and RSV calculations; 
• One of two RSV calculation methods can be selected: as the input data is acceleration, the integration 

to velocity can be performed either in the frequency domain or in the time domain; 
• CAV integration limit can be adjusted too though it is not required for the standard applications because 

the default value of 0.025g is specified by the Regulatory Guide 1.166 based on EPRI TR-100082. 
 
The group “OBE/SSE Check Parameters” specifies two sets of frequency ranges and the absolute limits for 
OBE and SSE. Click the corresponding radio button to switch between these two sets of parameters. The 
event meets OBE or SSE criterion if at least one CAV component exceeds the specified limits and if at least 
one component of RSA or RSV exceeds their limits within the specified frequency range interval. The limits 
are set separately for horizontal and the vertical components.  
 
The group of parameters called “Automatic Event Checks” is used for this type of checks only. First of all, 
enable the automatic checks by setting the option Event recorded by… Then the other parameters can be 
adjusted. Only those events recorded by the sites (stations) listed in the table will be checked automatically. 
The list of stations indicates which limit file belongs to which station and whether the results of event check 
of a particular station are used to generate the OBE and SSE alarms. The list of stations is edited through the 
context menu. The limit files are selected also with this menu from the directory specified as Path to limit 
files. Please refer to the section Editor of Limit Files for more information about these files. The editor is 
launched directly from the Event Check Parameters dialog by pressing the button [Edit Limit Files…]. The 
results of event checks can be forced to positive for testing purposes by enabling one or more Force… 
options. Note that if you would like to force the events to OBE or SSE, they will be forced also to Seismic. You 
can also specify whether the reports on results of event checks are printed automatically and for which 
types of events. An Example of the report of event check is presented below. Several features of this 
printout, such as title and the logo can be modified and they can be different for the first and for next pages of 
the report. Press the buttons [First Page…] and [Other Pages…] correspondingly to adjust the layout of 
report pages with the standard Print Setup dialog. Note that the parameters, which are shown in grey colour, 
cannot be changed. 

22.2 Manual Event Check 
Any event file can be checked manually if it meets 
the seismic and OBE/SSE criteria. This is done with 
the menu item Analyse -> Manual Event Check. 
First of all you will be asked to select an event file 
for checking, then the Manual Event Check window 
comes up. You have to select both the RSA and 
RSV limit files, which are used during the check 
procedure. Other check parameters are those 
specified in the Event Check Parameters dialog 
window. You can modify them for every performed 
check by pressing the button [Settings…]. In order 
to query the information about selected file press the 
button [File Info…]. The general information stored 
in the header of a selected data file will be 
displayed. To perform the check itself press the 
button [Check Now]. This opens the lower part of 
window where the brief results are displayed. In 
order to view and analyse the detailed results of the 
event check, press the button [More…>>]. The right 
hidden part of the window containing all the detailed results will be open. If the option Create graphical 
output… was enabled prior to check, the graph window containing the RSA, RSV and CAV curves with the 
corresponding limits as well as the original waveforms is created. 

 Event files checked for OBE/SSE must hold acceleration data in ‘g’ units. Only in this case the checks 
are performed correctly. 
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22.3 Results of Event Checks 

This window comes up at GeoDAS startup if the automatic event check (i.e. the option Event recorded by 
the stations…) is enabled in the Event Check Parameters dialog. The window cannot be closed, it can only 
be minimised instead. The information indicated in this window is described below. Note that this information 
reflects the results of checking of a single event file, which has the maximum number of positive check 
results. This is true for all columns except: Date and Time, No.Rec, Seismic and Status. They indicate 
characteristics of the group of event files related to the common event. 
 

 
 
 
Event date 
and time 

The date and time of the very first local trigger out of all files related to the current event. 
This time is declared as the event time 
 

No.Rec. This and the next three parameters are related to the seismic checks. It is indicated in the 
form A/B, where A is the total number of event files with the trigger times within the 
specified time frame whereas B is the number of files, which meet the next two criteria 
and therefore they can be declared seismic 
 

FFT The character ‘+’ (plus) in this column indicates that the event meet FFT criterion, i.e. its 
FFT peak is below the specified maximum 
 

Duration The character ‘+’ (plus) in this column indicates that the event duration is longer than the  
 

Seismic Indicates with ‘+’ whether the event is seismic. The common event must meet all seismic 
criteria, including the number of seismic files in the event. If the character ‘T’ (test) 
appears next to plus, this event was forced to seismic for the test purposes. 
 

OBE RSA, 
RSV and CAV 

The results of corresponding OBE-related checks. Plus indicates that the signal exceeded 
the specified limit for RSA, RSV and CAV correspondingly 
 

OBE The result of OBE check: OBE = (RSA or RSV) and CAV. Plus indicates that the event is 
OBE. ‘T’ indicates that the positive result is forced. If the OBE alarm was generated, it is 
indicated with the letter ‘A’ 
 

SSE RSA, 
RSV and CAV 

The results of corresponding SSE-related checks. Plus indicates that the signal exceeded 
the specified limit for RSA, RSV and CAV correspondingly 
 

SSE The result of SSE check: SSE = (RSA or RSV) and CAV. Plus indicates that the event is 
SSE. ‘T’ indicates that the positive result is forced. If the SSE alarm was generated, it is 
indicated with the letter ‘A’ 
 

Report Status Indicates whether report with the results of event check was printed. The status can be 
one of the followings: 
• No Report – the report will not be printed automatically 
• Pending – the report was prepared and will be printed automatically within 2 minutes 
• Printing – printing is in progress 
• Printed – the report was printed at least once, either automatically or by the user’s 

request. The report can be re-printed at any time 
 



GeoDAS_Manual.doc/03.09.2003  GeoSIG Ltd. 
GeoDAS Software Manual  Page 22-52 

22.4 Context Menu of the Results of Event Checks Window 
This context menu is shown in the above picture. Most of the items are available only if some event in the list 
has a focus, i.e. its date/time is surrounded by the dotted rectangle. Only one event can have such a focus at 
any particular time and the listed below operations are applied to this event: 
 
 User Comment   

Lets the operator to enter any comment line, which appears on the first page of the printed report right 
below the title. 

 

 View Graphs     

Shows all event waveforms in one window. 

 

 View Results     

Shows the results of event check for the selected event. The original waveform of every event record 
as well as the results of RSA, RSV and CAV operations are presented in one ODV window. 

 

 Re-check Event    

The event is re-checked with the current Event Check Parameters. If these parameters have been 
changed since the time of first event check, the results can differ from the ones indicated in the table. 
The results are shown in 
the Seismic Check 
Results window. The left 
part of this window shows 
common seismic and 
OBE/SSE check results. 
The event records are 
listed in the right part of 
window. The results 
indicated here are related 
to the particular event 
record only. In order to 
view and analyse the 
detailed information on 
every event file, select a 
site in the table and press the button [More Info]. 
 

 Print Report     

Lets the user to re-print the report on event check at any time. This might be needed if one or several 
more event files were added to the event after printing the report for the first time. An example of 
printout is shown below; see Example of the report of event check. 

 

 Detailed Information   

All event files, which belong to the current event, are listed in this submenu. The strongest event 
showing the maximum number of positive checks is highlighted. Upon choosing any file from this 
submenu the window displaying the detailed information comes up.  

OBE/SSE RSA and RSV check related parameters have the following meaning: 
• Comp. – name of the data component; 
• Fp – frequency (Hz), at which the response spectrum curve reaches its maximum; 
• RSA(V)p – maximum value of the response spectrum; 
• Fobe(sse) – frequency (Hz) within the specified check frequency range, at which the OBE or SSE 

limit exceeding was detected for the first time; 
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• RSA(V)obe(sse) – value of the 
response spectrum  at above frequency 
Fobe(sse); 

• Lfix – specified fixed OBE or SSE limit; 
• Lref – reference OBE or SSE limit at 

the frequency Fobe(sse). If no design 
OBE or SSE limit (taken from the 
corresponding design limit file) is 
specified at this frequency then Lref is 
always equal to Lfix, otherwise it is the 
maximum value of Lfix and the 
interpolated design OBE or SSE limit at 
the frequency Fobe(sse). 

 
All values described above are indicated in 
the graph below using an exapmle of OBE RSA Check related parameters for the component X 
highlighted in the “Detailed Information” dialog. Note that though OBE exceeding takes place below 
1Hz, it was declared only at 2.11Hz, which is the first calculated frequency point that lays within the 
specified frequency check interval 2 to 10Hz. 

 

OBE Limit curve RSAp=0.5285g at Fp=4.22Hz

RSAobe=0.4238g at Fobe=2.11Hz

OBE Limit curve

Lfix=0.2g 

Lref=0.3489g at Fp=2.11Hz 

 
OBE/SSE CAV check related parameters are similar to those described above, except there is no 
design limit for CAV and the relative time values (from the beginning of the record) are given in 
seconds instead of the frequency points. 

The next two menu items are always available irrespective of event selection. 

 Add Event Record    

With this menu item the operator can select manually any event file located everywhere on the hard 
disk or diskette and add it to the list of events. This is useful in case GeoDAS cannot access a 
particular station through the communication channel but still this station records event files, so they 
can be retrieved locally, e.g. with a laptop, and then can be read from a diskette. 

 Lock GeoDAS Screen  

For security reasons the main GeoDAS window can be locked (made invisible) so the unauthorised 
persons cannot access the main menu, change important parameters, etc. This action is protected 
with a password. The window Results of Event Checks still remains visible so the operators can see 
the results of performed checks, can print reports, etc. The same menu item is used for unlocking the 
GeoDAS screen. 

The next menu item is available when one or more events are selected (highlighted) in the list. 
 
 Delete Event Check Results  

The selected events are removed from the list permanently. Since this operation causes the loss of 
important information, it is protected with a password. It is the same password that is used for locking 
the GeoDAS screen. 
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22.5 Editor of Limit Files 
Limit files keep the design limits 
of RSA and RSV used for 
checking the events for OBE 
and SSE criteria. The absolute 
RSA and RSV exceeding limits, 
which are set through the Event 
Check Parameters dialog, are 
constants within the entire 
frequency check range. This is 
not satisfying to receive the 
precise results of event checks 
in many cases. In order to 
improve the situation, one can 
design any limit curves for all 
checked components of the 
source data by setting RSA and 
RSV limits in several frequency 
points within the check range. If 
both absolute and the design 
limits are available, the algorithm of event checks takes the greater limit to see whether the analysed signal 
exceeds it. 
 
Every line of the Table of Limits sets six limits for every frequency point: three of them are OBE limits for 
three different components of the signal and the other three are SSE limits. In order to add one more 
frequency point, one should press first the button [Insert Line] and then to enter a frequency and all six 
limits. Any value in the table is edited by double-clicking it. In order to delete a frequency point from the table, 
one should select the corresponding frequency and press the button [Delete Line]. 
 
The button [Import Data] is used to load the OBE and SSE limits from any text file. You can import either the 
entire ASCII limit table if it matches the format of the Limit Editor table or just load a single column. The 
number of column is selected with the Data Import Options dialog, which 
pops up after selecting a file to import. The data column(s) will be 
imported starting from the data cell currently selected (highlighted) in the 
Table of Limits. 
 
Limit files keep also the damping coefficients for every component of the 
signal. Typical damping value is 5%, which is entered as 0.05. 
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22.6 Example of the report of event check 
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23 Appendix K. Station Map 
If you have many stations configured, it might be useful to prepare the map showing the area where they are 
located. GeoDAS can display this map. 
 
First of all, the image file with the background map information must be prepared. For instance the JPEG 
format can be used for such a file. This file can be placed to any directory. The next step it is to provide the 
information on how to convert the graphical offsets in the image to the real latitude and longitude. In order to 
do so, prepare the text file GeoDAS_Maps.gsm and save it in the subdirectory Maps of the GeoDAS home 
data directory. 
 
This file must have the following format: 
Line 1: the full path to the background map file 
Line 2: graphical co-ordinates (left, top, right, bottom) 
Line 3: corresponding real co-ordinates (long1, lat1, long2, lat2) 
 
Example of GeoDAS_Maps.gsm file: 
e:\cpp\test\geodas\maps\map.jpg  
51 35 997 680 
28.5 40.75 29.5 41.3 
 
The locations of the stations are taken from the file all_stations.lst, which is kept in the subdirectory Config 
of the GeoDAS home data directory. Every line of this file indicates the name of a station, its latitude and 
longitude. 
 
Example of all_stations.lst file: 
ST000 40.842029 28.962203 
ST001 40.942618 28.618076 
ST002 41.105617 29.178060 
ST003 41.214980 29.038469 
ST004 41.152524 28.638798 
ST005 40.784211 29.137410 
ST006 40.759095 29.212271 
ST007 41.120540 28.986831 
 
If everything was prepared correctly then the background map with the stations placed on it will be displayed 
upon clicking the item View->Station Map of the main GeoDAS menu. 
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24 Appendix L. Support for ADC boards 
GeoDAS can acquire data directly from an A/D converter board, which is installed in the computer where it 
runs. The only type of ADC boards supported currently is the PC-CARD DAS16/12 manufactured by 
Measurement Computing Inc. (MCC). GeoSIG Ltd. has developed the computer-based version of seismic 
recorder named GSR-12PC, which utilises this type of A/D converter. For more information regarding GSR-
12PC product please refer to the corresponding hardware manual. 
 

24.1 Installation of the ADC board drivers 

Prior to use GeoDAS with an ADC board make sure that all required drivers and libraries provided by 
the board manufacturer are installed correctly in the computer running GeoDAS. Please refer to the 
installation instructions supplied along with your board. 
 
In some case it is required to run a configuration utility, which is used to adjust the main hardware settings of 
the ADC board and to test its general functionality. 

24.2 Configuration of ADC channels 
The A/D units are introduced to GeoDAS with the following configuration dialog launched from the main menu 
Settings->Configure ADC Channels. 
 
In most cases the configuration of ADC units and channels is edited locally, i.e. in the same computer where 
they are installed. In such a case the Local configuration type has to be selected. The location of 
configuration files is shown below. 
It is the Config directory, which is 
under the GeoDAS root data 
directory of the local computer. 
This location cannot be changed 
unless GeoDAS is fully 
reinstalled. When the type 
Remote configuration is 
selected, one can choose any 
location of the configuration 
files either by pressing the 
browse […] button or simply by 
typing any valid path in the edit 
bar. This feature is used to edit 
the configuration of a remote 
GeoDAS based data acquisition 
system accessible via network. 
The corresponding configuration 
directory on the remote computer 
must be shared as a network 
resource for the remote access. 
 
The group of controls called Main 
Configuration Parameters 
includes three settings. ADC unit 
name is assigned by user and 
may have up to three characters. In order to add an ADC unit into the current configuration simply type the 
desired name and press the button [Apply], which is used to verify and to update the current parameters of 
the dialog window. The sampling rate is the same for all channels and can be on of the following fixed 
values: 100, 200, 250, 500, 800 and 1000 samples per second. ADC unit type is the type of your A/D 
converter board. Besides of the real ADC unit, you may select also the type called Internal Simulator. In this 
case the data are generated internally by GeoDAS, which is useful for the test purposes. The button 
[More…] available for this type brings you to the Datastream Simulator Settings dialog described in the 
chapter Work Options. Here you can edit parameters of all ten simulated channels. 
 
Parameters of ADC channels are placed to the table at the bottom of configuration dialog. For every available 
channel one can select whether it provides data to the acquisition system (enabled - Yes) or not, one can 
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enter up to five characters for both channel name and a unit name. The LSB values are the factors used to 
convert raw counts to the physical units indicated in the last column of the table. The Appendix A. Information 
on LSB contains some more information about this issue. Since some types of GeoSIG sensors support 
three different gains, three sets of LSB factors can be entered for every configured channel. The selection of 
an appropriate gain for these sensors is made with the combo box Sensor gain. 
 

The Gain 1 must be chosen for the sensors, which do not support different gains. Please refer to the 
hardware manual of your sensor for more information about supported gains in order to select the correct 
LSB factors.  
 
The button [Streams…] opens the Datastream Manager Setup window described in the chapter Processing 
Stream Data. It is used to adjust trigger settings and some other parameters for processing of data streams. 
Note that it is possible to edit both local and remote sets of parameters depending on the type of 
configuration currently selected. But there are exceptions: options of the data forwarding, messages and 
notifications and the target communication port for the Early Warning alarm messages cannot be adjusted 
remotely. 
 
An ADC unit is removed from the current configuration by pressing the button [Delete]. When all parameters 
are adjusted as required, hit the [OK] button, and the local data acquisition and processing will be restarted 
after the confirmation. If the parameters of a remote GeoDAS were modified, it will usually take 10-20 
seconds to update all parameters and to restart data acquisition at the remote computer. If the restart was 
performed correctly, you will receive the corresponding message. 
 

24.3 Processing ADC data channels 
The acquisition and processing of the data provided by ADC channels is very similar to processing of the data 
streams delivered by the standard GeoSIG instruments, such as GSR-18/24 and GBV. All aspects of this 
issue are described in details in the chapter Working with Data Streams. Several little differences are listed 
below: 
• Synchronisation with the GPS time is not currently supported and therefore the GPS status is always 

indicated as “Not Sync”; 
• In case of the normal operation of ADC units, the data packets are never lost, so the percentage of data 

lost is not counted; 
• Recording of the sensor test pulse files is only possible for the ADC units of the type PC-CARD 

DAS16/12 integrated into the GSR-12PC recorders; 
• Event files recorded form the data streams provided by ADC units do not contain some instrument-

specific information, such as battery voltages, errors and warnings, location information, etc. 
 
As it takes place with the data streams from standard instruments, both permanent and the event-based 
recording of data are possible for ADC channels. In order to keep compatibility with the standard GSR event 
files, the enabled data channels of any configured ADC unit are splitted into the groups, which appear in the 
Data Streams information window as ‘stations’ with the names consisting of three-character unit name and 
trailing numbers 01, 02, etc. Three first enabled channels are assigned to the station 01, three next enabled 
channels are assigned to the station 02, etc.  
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